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Safety precautions

The following precautions ensure the proper use of the printer and prevent the printer from being
damaged. Follow these precautions at all times.

e Use the power supply voltage specified on the nameplate. Avoid overloading the printer's electrical
outlet with multiple devices.
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e  Ensure the printer is well-grounded. Failure to ground the printer may result in electrical shock, fire
and susceptibility to electromagnetic interference.

e Do not disassemble or repair the printer yourself. Contact your local HP Service Representative
for service, see Contact HP Support on page 190.

e Use only the electrical cord supplied by HP with the printer. Do not damage, cut or repair the power
cord. A damaged power cord has risk of fire and electric shock. Replace a damaged power cord
with an HP-approved power cord.

e Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of
the printer. Doing so may cause fire, electric shock or other serious hazards.

e  Turn off the printer and unplug the power cable from the power outlet in any of the following cases:
o When placing your hands inside the printer
o If there is smoke or an unusual smell coming from the printer
o If the printer is making an unusual noise not heard during normal operation

° A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal
parts of the printer

° During a thunderstorm

° During a power failure

HP Start-Up Kit

The HP Start-Up Kit is the CD that comes with your printer; it contains the printer's software and
documentation.

Using this guide

This guide can be downloaded from the HP Knowledge Center (see Knowledge Center on page 188).

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics.

° Installing the software on page 11

° Setting up the printer on page 21

° Personalizing the printer on page 27

° Paper handling on page 33
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° Working with two rolls (T1200 series only) on page 49

° Printing on page 53

° Color management on page 69

° Practical printing examples on page 81

° Job queue management on page 107

° Retrieving printer usage information on page 113

° Handling ink cartridges and printheads on page 117

° Maintaining the printer on page 129

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.

e Troubleshooting paper issues on page 143

° Troubleshooting print-quality issues on page 155

e Troubleshooting ink cartridge and printhead issues on page 171

° Troubleshooting general printer issues on page 179

° Front-panel error messages on page 185

Accessories, support and specifications

These chapters, Accessories on page 135, HP Customer Care on page 187 and Printer
specifications on page 191, contain reference information, including customer care, the printer
specifications and part numbers for paper types, ink supplies and accessories.

Glossary

The Glossary on page 209 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent
the printer from being damaged. Follow the instructions marked with these symbols.

A WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal
injury or death.

/A CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury
or damage to the product.

Printer models

This guide covers the following printer models, normally referring to them by their short names for brevity.
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Full name Short name

% HP Designjet T770 T770

g' HP Designjet T770 with PostScript Upgrade accessory T770 PS

%‘ HP Designjet T770 Hard Disk Version T770 HD

= HP Designjet T770 Hard Disk Version with PostScript Upgrade accessory T770 HD PS
HP Designjet T1200 T1200
HP Designjet T1200 PostScript Version T1200 PS

The printer's main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 44 inches
(1.12 m) wide. Some major features of the printer are shown below:

e  Print resolution of up to 2400 x 1200 optimized dpi, from a 1200 x 1200 dpi input, using the Best
print-quality option, the Maximum Detail option and photo paper

e The HP Utility, see Access the HP Utility on page 29, provides an easy-to-use interface including:

° Job management, see Job queue management on page 107

° Printer calibration

o Access to the online HP Knowledge Center (see Knowledge Center on page 188)

e Paper flexibility and automatic easy load, see Paper handling on page 33, with information and
presets accessible from the front panel and the HP Utility

e Handles cut-sheet and roll paper
e  Six-ink system
e Accurate and consistent color reproduction with automatic color calibration

° Color emulations, see Printer emulation on page 72

e Economode for printing economically

e Two rolls loaded at once provide fast and easy switching between different rolls, or long runs of
unattended printing (T1200 series only)

e High productivity features such as job previewing and nesting using the HP Utility or the printer's
Embedded Web Server (T1200 series only)

e Ink and paper usage information available from the Embedded Web Server, see Access the
Embedded Web Server on page 29
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The printer's main components

The following front and rear views of the printer illustrate the main components.

Front view
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1. Ink cartridge

2. Ink cartridge slots

3. Blue lever

4. Window

5. Front panel

6. Printhead carriage

7. Printhead

8.  Output tray

9. Paper alignment lines

10. Basket
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Rear view

HP Designjet T1200 series HP Designjet T770 series
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1. Roll cover

2. Communication ports
3. Power switch

4.  Power socket

5. Spindle

6. Spindle stop
7.  Paperroll

8. Quick Reference Guide holder
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Communication ports
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1. USB 2.0 port, to connect a computer
2. Ethernet port, to connect to a network
3. Diagnostic LEDs, to be used by service engineers

4. USB 2.0 host port, to connect an accessory

The wall spacers

If you place the printer with its back against a wall, lower the two wall spacers at the rear of the printer
to ensure that the rear of the printer is a minimum distance from the wall. Otherwise, you may experience

paper advance problems.
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The front panel

Your printer's front panel is located on the front of the printer, in the center. It has the following important
functions:

e Assists you in troubleshooting issues
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e Is used to perform certain procedures, such as cutting and unloading paper

e Displays helpful animations to guide you through procedures

e Displays up-to-date information about the status of the printer such as, the ink cartridges, the
printheads, the paper and the print jobs

o Displays warning and error messages, when appropriate, along with audio alerts to call attention
to a warning or message

e Can be used to change the values of printer settings and thus change the operation of the printer.
However, settings in the front panel are overridden by settings in the printer drivers, see Installing
the software on page 11

HP Designjet T1200 series HP Designjet T770 series

The front panel has the following components, starting with the four direct-access keys:

1. View ink levels key: see Check the ink cartridges status on page 118.

2. View information key. By pressing this key repeatedly, you can see information about all loaded
papers (roll 1, roll 2, sheet) and about the printer's connection to the computer. See View
information about the paper on page 44.

3. Pause printing key (T1200 series) pauses printing after finishing the current page. Press the key
again to restart printing. This can be useful, for instance, when you want to change or load a roll.

Unload paper key (T770 series) unloads the currently-loaded paper (roll or sheet).

4. Form feed and cut key: see Feed and cut the paper on page 47.

5.  Front-panel display - Displays errors, warnings and information on using your printer.

6. Back key - To go to the previous step in a procedure or interaction. To go to the upper level, or
leave the option in the menu, or when given an option.

7.  Menu key - Press to return to the main menu of the front-panel display. If you are already on the
main menu it will display the status screen.

8. Down key - To go down in a menu or option, or to decrease a value, for example when configuring
the front-panel display contrast or the IP address.
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10.

11.

12.

13.

Power key - To turn the printer off or on, it also has a light to indicate the printer's status. If the
power key light is off the printer is off. If the power key light is blinking green, the printer is starting
up. If the power key light is green on, the printer is on. If the power key light is amber on, the printer
is in standby. If the power key light is blinking amber, the printer needs attention.

Cancel key - To abort a procedure or interaction.

Up key - To go up in a menu or option, or to increase a value, for example when configuring the
front-panel display contrast or the |IP address.

OK key - To confirm an action while in a procedure or interaction. To enter in a submenu in the
menu. To select a value when given an option. If the status screen is displayed, this key takes you
to the main menu.

Status light - Indicates the printer's status. If the Status light is solid green, the printer is ready. If it
is flashing green, the printer is busy. If it is solid amber, there is a system error. If it is flashing
amber, the printer needs attention.

To highlight an item in the front-panel display, press the Up or Down key until the item is highlighted.

To select an item in the front-panel display, first highlight it and then press the OK key.

When this guide shows a series of front-panel display items like this: Item1 > Item2 > Item3, it means
that you should select ltem1, then select ltem2, then select ltem3.

Information about specific uses of the front panel can be found throughout this guide.

Printer software

The following software is provided with your printer:

ENWW

The HP-GL/2 and HP RTL driver for Windows
The PCL3 raster driver for Mac OS (T770 and T1200)
The PostScript drivers for Windows and Mac OS (T770 PS and T1200 PS)

The HP Utility, see Access the HP Utility on page 29, allows you to:

o Manage the printer including color with the HP Color Center
° View the status of the ink cartridges, the printheads and the paper

° Access the HP Knowledge Center, see Knowledge Center on page 188

° Update the printer's firmware, see Update the firmware on page 131

o Perform calibrations and troubleshooting

° Manage the job queue, see Job queue management on page 107

> View job accounting information, see Retrieving printer usage information on page 113

° Change various printer settings (in the Settings tab) (T1200 series only)

The Embedded Web Server runs in the printer and enables you to use a Web browser on any
computer to check ink levels and printer status, see Access the Embedded Web Server

on page 29.

Printer software 9
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The printer's internal prints

The internal prints give various kinds of information about your printer. They can be requested from the
front panel without using a computer.

Before requesting any internal print, check that the printer and the paper are ready for printing.
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e The print will be made on the active roll. To change the active roll, select the Paper menu icon

, then Select active roll.

e The loaded paper should be at least A3 landscape (16.53 in or 42 cm wide), otherwise the print
may be clipped.

e The front panel should be displaying the Ready message.
To print any internal print, select the Internal Prints menu icon , then select the internal print you
want. The following internal prints are available.
e Demo prints: show some of the capabilities of the printer
o Print drawing demo
o Print rendering demo
° Print GIS map
e Menu map: shows details of all the front-panel display menus
e Configuration: shows all the current front-panel display settings

e Usage report: shows estimates of the total number of prints, number of prints by paper type, number
of prints by print-quality option and total amount of ink used per color (the accuracy of these
estimates is not guaranteed) (T770 HD and T1200 series only)

e HP-GL/2 palette: shows the color or grayscale definitions in the currently selected color palette
e Service information: provides information needed by service engineers

e  PostScript font list: shows PostScript fonts available (PostScript printers only)

10 Chapter 1 Introduction ENWW



ENWW

Installing the software

° Choose which connection method to use

° Connect to a network (Windows)

e Connect directly to a computer (Windows)

° Uninstall the printer software (Windows)

e Connect to a network (Mac OS)

e Connect directly to a computer (Mac OS)

e Uninstall the printer software (Mac OS)
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Choose which connection method to use

The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors
Ethernet Very fast; varies Long (100 m = 328 ft) Requires extra equipment (switches)
according to network
traffic
Jetdirect print server Moderate; varies Long (100 m = 328 ft) Requires extra equipment (switches)
(optional accessory) according to network
traffic Provides additional features

See http://www.hp.com/go/jetdirect/ for
more details

USB 2.0 Very fast Short (5 m = 16 ft) A certified USB 2.0 cable is necessary for
reliable communication.

Bf NOTE: The speed of any network connection depends on all components used in the network, which
can include network interface cards, hubs, routers, switches and cables. If any one of these components
cannot operate at high speed, you will have a low-speed connection. The speed of your network
connection can also be affected by the total amount of traffic from other devices on the network.

Connect to a network (Windows)

Before you begin, check your equipment:

e  The printer should be set up and on.

e The Ethernet hub or router should be on and functioning correctly.

e All computers on the network should be on and connected to the network.
e  The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer:

1. Make a note of the printer's IP address from the front panel (see Access the Embedded Web
Server on page 29).

2. Insert the HP Start-Up Kit CD into your computer. If the CD does not start automatically, run the
autorun.exe program in the root folder of the CD.

3. Press the Express Network Install button, and choose your printer from the list of networked
printers that appears, identifying it by its IP address if necessary. The printer drivers and the HP
Utility are installed.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed,
which helps you to try to find your printer. If you have a firewall in operation; you may have to disable it
temporarily in order to find the printer. You also have the options of searching for the printer by its URL,
IP address or MAC address.

Connect directly to a computer (Windows)

You can connect your printer directly to a computer without going through a network, by using the
printer's built-in USB 2.0 port.

¥ TIP: A USB connection may be faster than a network connection, but the cable is limited in length and
it is more difficult to share the printer.

12 Chapter 2 Installing the software ENWW
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Bf NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified
by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

1. Do not connect the computer to the printer yet. You must first install the printer driver software
on the computer, as follows.

2. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not start automatically, run the
autorun.exe program in the root folder of the CD.

3. Press the Custom Install button.

4. Insome cases, you may see a message warning you that the installer would need to communicate
through the firewall in order to search the network for printers. As you have no need to do this, you
can check the box Continue installation without searching the network.

5. If you see a list of networked printers, select Help me find my printer (including network, USB
or parallel connected printers).

6. Select USB Cable.

EBf NOTE: You can connect your printer and complete the installation later if you prefer. To do so,
check the box marked | want to connect my printer after completing the setup wizard.
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7. When prompted to do so, connect your computer to the printer with a certified USB cable. Ensure
that the printer is turned on.

8.  The printer drivers and the HP Utility are installed.

X TIP: If you would like to share the printer with other people connected to your network, press the
Printer Properties button in the Ready to Install window, set Printer Name to the name under which
the printer will be shared, then set Shared to Yes.

Printer sharing considerations
e  The HP Utility must be installed on a computer before it can be used from that computer.

e Any other users sharing your directly connected printer will be able to send print jobs, but will not
be able to receive information from the printer—which affects printer alerts, printer status reports,
paper management, printer administration and troubleshooting.

e Any other users sharing your directly connected printer will be unable to use the printer's own print
preview facility, although the application's print preview will still be available. See Preview a print

on page 60.

X TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Windows)on page 12.

Uninstall the printer software (Windows)

1. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not start automatically, run the
autorun.exe program in the root folder of the CD.

2. Press the Modify Installation button, and follow the instructions on your screen to uninstall the
printer software.

ENWW Uninstall the printer software (Windows) 13
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Connect to a network (Mac OS)
You can connect your printer to a network under Mac OS X by using the following methods:
e  Bonjour/Rendezvous

e TCP/IP

Bf NOTE: The printer does not support AppleTalk.

Before you begin, check your equipment:

e  The printer should be set up and on.

e  The Ethernet hub or router should be on and functioning correctly.

e  All computers on the network should be on and connected to the network.
e The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer.

Bonjour/Rendezvous connection

1 Goto your printer's front panel and select the Connectivity menu icon .I then Fast Eth

or Gigabit Ethernet > View configuration. Note the mDNS service name of your printer.
2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.
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4. Open the Mac OS X HP Designjet Installer.

Mac 05 X HP Designjet Installer

- Introduction Welcome to the HP Instalber!
= Overdew
mstablan

Thank you for choosing HP.

This program lats you sasily install and et up your HP device or saftwars so you
SN BTAFT WEInG it right away.

| When avaitable, click the Mare Info.., button 1o get help and details,

{ Gotlack B Continue

5.  Follow the instructions on your screen.
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6.  The printer software is installed, including the printer driver and the HP Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer. Follow the instructions on your screen.

8.  When you reach the Select Printer screen, look for your printer's mDNS service name (which you
noted in step 1) in the Printer Name column.

HP Printer Setup Assistant

Select Printer

Select wour printer From the list below and click Cantinee to procesd

Prirter Kame Primter Mode| Frimter Driver
O WTIAITEL AVAWMRE TN L 1 WEIRTITEL L RS e

T HP Designjer Z3200ps 44in Photo [ HP Designjet 232 PostSeript

B HP Designjet 23200ps 44in Photo [, HF Designjec 232 .. PCLI Raster
B HP Designjet T1200 [ASECAT] HP Designjet T12... PCLY Raster
7 HP Designjet 510 24in Printer (CHI HP Deshgnjet 510 PCLY Baster
= WP Designjet T1120ps 44in [AJDC44) HP Designjet T11... PostSeript

@ HP Designjet T1200 [A4ECS4] HE Designjet T12.. PCLI Raster
‘B_HP Desioniec T1200 IA4ECAQ) HP Desionker T12... PCLI Raster

e g -

P

' My printer is not an the list Refresh List )

e If you find the right printer name, scroll sideways if necessary to see the Connection Type
column, and check that it shows Bonjour/Rendezvous. Then highlight that line. Otherwise,
continue searching further down the list.

e If you cannot find your printer name with a Bonjour/Rendezvous connection type, check the
box My printer is not in the list.

Click Continue.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
CD.

ENWW Connect to a network (Mac OS) 15
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TCP/IP connection

1.  Go to your printer's front panel and make a note of the printer's URL (see Access the Embedded
Web Server on page 29).

2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.
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4. Open the Mac OS X HP Designjet Installer.

M 05 X HP Designjet Inataller

" Intreduction Welcome to the HP installer!
o Overview
» Lice
L
mstallatic

Thank you for choesing HP.

This program leis you easily Install and set up your HP device or software so you
| ean stars using It right away.

|
When available, click the More Info... button 1o get help and details.

o _

]
[ Gofack W Continue

5. Follow the instructions on your screen.
6.  The printer software is installed, including the printer driver and the HP Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer. Follow the instructions on your screen.

8.  When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1)
in the Printer Name column.

e If you find the right printer name, scroll sideways if necessary to see the Connection Type
column, and check that it shows IP Printing. Then highlight that line. Otherwise, continue
searching further down the list.

e If you cannot find your printer name with an IP Printing connection type, check the box My
printer is not in the list.

Click Continue.
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9. Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
CD.

Connect directly to a computer (Mac OS)

You can connect your printer directly to a computer without going through a network, by using the
printer's built-in USB 2.0 port.

1. Make sure the printer is either turned off, or disconnected from the computer.
2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.
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4. Open the Mac OS X HP Designjet Installer.

Mac 05 X HP Desigrijet Inataller

" Introduction Welcome to the HPF installer!
= Oversiew
" Lice
®  Model
estallatio

Thank you for choosing HP.

This program leis you easily install and set up your HP device or software so you
& Summary | can start using it right away.

|
When available, click the More Info... button to get help and details.

" _

]
| Gollack B Continue }

5. Follow the instructions on your screen.
6.  The printer software is installed, including the printer driver and the HP Utility.

7. Make sure that the printer is turned on and connected to the computer with a certified USB cable.

ENWW Connect directly to a computer (Mac OS) 17
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Bf NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

8.  Shortly afterwards, a print queue is created automatically for your printer.

Sharing the printer

Ef NOTE: Printer sharing between users is supported under Mac OS X 10.4 and 10.5.

If your computer is connected to a network, you can make your directly connected printer available to
other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.
2. Enable printer sharing by going to Sharing > Services > Printer Sharing.

3. Your printer now automatically appears in the list of shared printers displayed by any other
computer running Mac OS and connected to your local network.

Please bear in mind the following considerations.

e Any other users wishing to share your printer must install the printer software on their own
computers.

e Anyone sharing your directly connected printer will be able to send print jobs, but will not be able
to receive information from the printer—which affects printer alerts, printer status reports, paper
management, printer administration and troubleshooting.

e The PCL3 (raster) driver can drive a shared printer between different versions of Mac OS, but the
PostScript driver does not support printer sharing between Mac OS X 10.4 and Mac OS X 10.5.

e You may find that sharing your directly connected printer with other users will slow down your
computer unacceptably.

X TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Mac OS)on page 14.

Uninstall the printer software (Mac OS)
1. Insert the HP Start-Up Kit CD into your CD drive.

2. Open the CD icon on your desktop.
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3. Open the Mac OS X HP Designjet Uninstaller, and follow the instructions on your screen to
uninstall the printer software..
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To delete the print queue:

e Under Mac OS X 10.4 or 10.5: from the system preferences, select the Printing pane of the Print
& Fax dialog. Select the name of the printer and click the — button.

e Under Mac OS X 10.4: from the Print Setup utility, select the name of the printer and click the
Delete icon.

Bf NOTE: Under Mac OS X 10.4, both methods are available.
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Setting up the printer

° Introduction

° Handle paper conflicts (T1200 series only)

e Turn nesting on and off (T1200 series only)

e Turn usage information on and off

e Turn alerts on and off

e Control access to the printer

e Require account ID (T1200 series only)

e Set Windows driver preferences
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Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soon
as a new printer is assembled and ready for use.

Handle paper conflicts (T1200 series only)

Paper mismatch action

If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put
the job on hold until some suitable paper is loaded, or it can ignore the problem and print the job on the
unsuitable paper. There are several ways in which the loaded paper may be considered unsuitable:

e The paper type is not as specified for the job

e  The paper source (roll 1, roll 2 or sheet) is not as specified for the job
e The paper size is smaller than specified for the job

You can set the printer's behavior in such cases from the front panel.

®  Select the Setup menu icon , then Job management options > Paper mismatch action >

Print anyway if you want such jobs to print on whatever paper is loaded. This is the default option.

®  Select the Setup menu icon , then Job management options > Paper mismatch action >

Put job on hold if you want such jobs to be put on hold. The printer will send an alert whenever a
job is put on hold.

When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded
(in which case, all jobs waiting for that paper type can be printed). Meanwhile, other jobs with different
requirements can continue printing.

Roll switching options

Turn

If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your
preferences. These can be set from the front panel: select the Setup menu icon , then Printing

preferences > Paper options > Roll switching options. There are three available options:

e Minimize paper waste. If this option is chosen, the printer will choose the narrowest roll that meets
all the criteria, to avoid wasting paper due to trimming. This is the default option.

e Minimize roll changes. If this option is chosen, the printer will choose the roll that is currently
active, to avoid wasting time with a roll switch. To change the active roll, select the Paper menu

icon , then Select active roll.

e Useroll with less paper. If this option is chosen, the printer will choose the roll that has the least
unused paper.

nesting on and off (T1200 series only)

Nesting means automatically printing images or document pages side by side on the paper when
feasible, rather than one after the other. This is done to avoid wasting paper. See Nest jobs to save roll
paper (T1200 series only) on page 64.

To turn nesting on or off, you must first make sure that the job queue is enabled (see Turn off the job
queue (T770 HD and T1200 series only) on page 109) and the start of printing is set to After

22 Chapter 3 Setting up the printer ENWW



Processing (see Select when to print a job in the queue (T770 HD and T1200 series only)
on page 109). Then:

e Inthe HP Utility for Windows: select Settings > Job Management > Nest.

e Inthe HP Utility for Mac OS: select Configuration > Printer Settings > Configure Printer
Settings > Job Management > Nest.

e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Nest.

®  Using the front panel: select the Setup menu icon , then Job management > Nest
options > Enable nesting.

In each case, you will see the following options:

e Inorder: pages are nested in the order in which they are sent to the printer. The nested pages are
printed as soon as one of three conditions is met:

° The next page will not fit on the same row as the other pages already nested.

° No page has been sent to the printer during the specified wait time.

o The next page is incompatible with the pages already nested (see Nest jobs to save roll paper
(T1200 series only) on page 64).

e Optimized order: pages are not necessarily nested in the order in which they are sent to the printer.
When it receives an incompatible page, the printer holds it and waits for compatible pages to
complete the nest. The nested pages are printed as soon as one of three conditions is met:

° The next page will not fit on the same row as the other pages already nested.
° No page has been sent to the printer during the specified wait time.

° The incompatible-page queue is full. The printer can queue up to six incompatible pages while
nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it
is.
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e  Off: nesting is disabled. This is the default option.

The nesting wait time can be set at the front panel: Setup menu icon , Job management > Nest

options > Select wait time.

:- TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print
because the printer waits for compatible pages to arrive.

Turn usage information on and off

The printer can send usage information periodically by e-mail. You can request this in the following
ways:

e In the HP Utility for Windows: select Settings > Accounting.

e Inthe HP Utility for Mac OS: select Configuration > Printer Settings > Configure Printer
Settings > Accounting.

e Inthe Embedded Web Server: select Setup > Printer settings > Accounting.

ENWW Turn usage information on and off 23
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Turn

In each case, you must set the following options:

e Send accounting files: On (the default is Off)

e Send accounting files to: a valid e-mail address

e Send accounting files every: choose a number of days (1-60) or a number of prints (1-500)

You must also ensure that the e-mail server has been configured. To configure the e-mail server using
the Embedded Web Server, select Setup > E-mail server, and fill in the following fields:

e SMTP server: the IP address of the outgoing mail server (SMTP) that will process all e-mail
messages from the printer. If the mail server requires authentication, e-mail notifications will not
work.

e Printer e-mail address: each e-mail message sent by the printer must include a return address,
which does not need to be a real, functional E-mail address, but it should be unique, so that
recipients of the message can identify the printer that sent it.

alerts on and off

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when
one of your printing jobs changes its status. The alerts are displayed by the printer's front panel, by the
HP Utility, by the printer driver and by the Embedded Web Server.

You can tell the printer which kinds of alerts you would like to see (if any). To access the alert settings:
e Select Alert Settings in the Device List page of the HP Utility.

e Select Alert Settings in any alert page displayed by the HP Utility for Windows.

e Right-click the system tray icon of the HP Utility for Windows, and select Alert Settings.

You can change the settings in the following ways:

e  Turn all alerts on or off.

e  Turn job status alerts on or off (T1200 series only).

Turn on or off printer alerts for problems that stop the printer from printing.

Turn on or off printer alerts for problems that do not stop the printer from printing.

e Turnon printer alerts in all circumstances, or only when you are trying to print to the printer affected
by the problem.

Control access to the printer

From the Embedded Web Server, you can select Setup > Security to control access to the printer in
various ways:

e  Specify separate administrator and guest passwords to control access to the Embedded Web
Server

e Enable or disable Ethernet and USB connections to the printer
e Enable or disable various groups of front panel operations

If you forget the administrator password, you can delete the current password from the front panel: select
the Connectivity menu icon , then Advanced > Embedded Web Server > Reset EWS access

control.
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Access to the Networking page is protected by a different password (the administrator's password). To
reset the administrator's password, you need to reset the whole input/output configuration. Using the

front panel, select the Connectivity menu icon , then select your connection method (e.g. Gigabit

Ethernet), then Restore factory settings.

Bf NOTE: This will reset the whole input/output configuration, the printer will reset to the DHCP
configuration method and its IP address could change.

Require account ID (T1200 series only)

If you want to keep records of printer usage by different user accounts, you can set your printer to require
an account ID for each job.

e In the HP Utility for Windows: select Settings > Accounting > Require account ID.

e Inthe HP Utility for Mac OS: select Configuration > Printer Settings > Configure Printer
Settings > Accounting > Require account ID.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be
kept "on hold for accounting”.

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for
accounting" by the printer, you can introduce the account ID in the HP Utility by going to the Job
Center > Job Queue and clicking the job that is on hold. A window with a text box will be displayed and
you can enter the account ID into it.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for
instance to set color emulation or paper-saving options. To do this, press the Start button on your
computer's screen, then select Printers and Faxes. In the Printers and Faxes window, right-click on
your printer's icon, and select Printing Preferences. Any settings you change in the Printing
Preferences window will be saved as default values.
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4  Personalizing the printer

e Turn the printer on and off

° Change the language of the front-panel display

e Access the HP Utility

e Access the Embedded Web Server

e Change the language of the HP Utility

e Change the language of the Embedded Web Server

e Change the sleep mode setting

e Turn the buzzer on and off

e Change the front-panel display contrast

e Change the units of measurement

e Configure network settings

° Change the graphic language setting
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Turn the printer on and off

X TIP:  The printer can be left powered on without wasting energy. Leaving it on improves response time
and overall system reliability. When the printer has not been used for a certain period of time (the default
time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction
with the printer's front-panel display, or sending a new job to print, returns it to active mode, and it can
resume printing immediately. To change the sleep mode time, see Change the sleep mode setting

on page 30.

B NOTE: In sleep mode, the printer performs maintenance service to the printheads from time-to-time.
This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave
the printer powered on or in sleep mode to avoid wasting ink and time.

The printer has three levels of power consumption.

e Plugged in: the power cord is plugged into the back of the printer

e Switched on: the switch at the back of the printer is in the on position
e Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to
use the Power key on the front panel.

9)
However, if you plan to store the printer indefinitely or the Power key does not seem to work, you are
recommended to power it off using the Power key, and then also switch off the power switch at the rear.
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To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare
the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the printer
has been off for six weeks or more, preparing the printheads could take up to 45 minutes.
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Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.

If you can understand the current front-panel display language, select the Setup menu icon ,

then Front panel options > Select language.

e If you cannot understand the current front-panel display language, start with the printer powered
off. At the front panel, press the OK key and hold it down. While holding the OK key down, press
the Power key and hold it down. Continue to hold down both keys until the green light on the right
side of the front-panel display starts flashing, and then release both keys. You can expect a delay
of about one second. If the green light starts flashing without any delay, you may need to start
again.

Whichever method you used, the language selection menu should now appear on the front-panel
display. Highlight your preferred language with the Up and Down keys, then press the OK key.

When you have selected your preferred language, turn off the printer with the Power key and then turn
it on again. The front panel will appear in the selected language.

Access the HP Utility

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP or Jetdirect
connection.

e Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs >
Hewlett-Packard > HP Utility > HP Utility. This launches the HP Utility, showing the printers
installed on your computer.

e Under Mac OS, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK
> Library > Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the printers
installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific
to that printer.

If you have followed these instructions but failed to get through to the HP Utility, see Cannot access the
HP Utility on page 182.

Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web
browser running on any computer.
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To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer.
However, you can access the Embedded Web Server indirectly through the HP Utility, if you connect to
your printer with a USB connection.

The following browsers are known to be compatible with the Embedded Web Server:
e Internet Explorer 6 and later, for Windows

e Safari 2 and later, for Mac OS X 10.4

e Firefox 1.5 and later

To access the Embedded Web Server on any computer, open your Web browser and give the IP address
of your printer.
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You can see your printer's IP address (192.168.1.1 in this example) on the front panel's status
screen.

Ready

@@= Ut of paper
150%

QHP Coated Paper

Mttp: /A Rknnll

hitp:/7192.166.1.1

If you have followed these instructions but failed to get through to the Embedded Web Server, see
Cannot access the Embedded Web Server on page 182.

Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows
only), French, ltalian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

e Under Windows, select Tools > Set Language and select a language from the list.

e Under Mac OS, the language is changed as for any other application. In System Preferences,
select International and re-launch the application.

Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and
Japanese. It uses whichever language you have specified in your Web browser's options. If you have
specified a language that it cannot support, it works in English.

To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep
mode to save power. To change the time the printer waits before it goes into sleep mode, go to the front

panel and select the Setup menu icon , then Front panel options > Sleep mode wait time.
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Highlight the wait time you want and then press the OK key. You can set the time from 1 to 240 minutes.
The default time is 30 minutes.

Turn the buzzer on and off

To turn the printer's buzzer on or off, go to the front panel and select the Setup menu icon , then

Front panel options > Enable buzzer, and highlight on or off and press the OK key. By default, the
buzzer is set to on.
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Change the front-panel display contrast

To change the contrast of the front-panel display, select the Setup menu icon , then Front panel

options > Select display contrast, and enter a value using the Up or Down key. Press the OK key to
set the value. The default contrast is set to 50.

Change the units of measurement

To change the units of measurement in the front-panel display, select the Setup menu icon ,

then Front panel options > Select units, and select English or Metric. By default the units are set to
metric.

Configure network settings

You can view and configure the network settings from the HP Utility (T1200 series only). Under Windows,
select the Settings tab, then Network Settings. Under Mac OS, select Configuration > Network
Settings. The following settings are available.

e IP Configuration method: specify the way to set an IP address, selecting BOOTP, DHCP, Auto
IP or Manual.

e Host name: specify an IP name for the network device. The name may contain up to 32 ASCII
characters.

e |Paddress: specify the IP address on the print server. Duplicate IP addresses on a TCP/IP network
are not allowed.

5 NOTE: If you change the current IP address and click Apply, the browser loses the current
connection to the print server because it is pointing to the old address. To reconnect, browse to
the new IP address.

e Subnet mask: specify a subnet mask, which is a 32-bit number applied to an IP address to
determine which bits specify the network and subnet and which bits uniquely specify the node.

e Default gateway: specify the IP address of a router or computer that is used to connect to other
networks or sub-networks. If none exist, use the IP address of the computer or the IP address of
the print server.

e Domain name: specify the name of the DNS domain in which the print server resides (for example,
support.hp.com).

1),

NOTE: The domain name does not include the host name: it is not the fully qualified domain
name, such as printer1.support.hp.com.
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e Idle timeout: specify the number of seconds that an idle connection is allowed to remain open; 30
is the default value. If set to zero, the timeout is disabled and TCP/IP connections remain open
until closed by the other node (such as a workstation) on the network

e Default IP: specify the IP address to use when the print server is unable to obtain an IP address
from the network when powered on or when reconfigured to use BOOTP or DHCP.

e Send DHCP requests: specify whether DHCP requests are transmitted when a legacy default IP
address or a default Auto IP is assigned.

To configure the same network settings from the front panel, select the Connectivity menu icon .I
then Fast Ethernet or Gigabit Ethernet > Modify configuration.
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You have various other options available from the Connectivity menu icon.

USB: view information about the USB connection
Jetdirect EIO: view information, configure and reset the Jetdirect connection

Advanced > Select I/0O timeout: specify the number of seconds that an idle connection is allowed
to remain open, 270 is the default value, if set to zero, the timeout is disabled

Advanced > Allow SNMP: specify whether SNMP is permitted

Advanced > Embedded Web Server > Allow EWS: specify whether the Embedded Web Server
is enabled

Advanced > Web Services > HP Utility software: view the HP Utility software settings

Advanced > Web Services > Color and paper management: view the color and paper
management settings

Change the graphic language setting

You can change the graphic language setting from the HP Utility with the following steps (T1200 series
only).

1.

Under Windows, select the Settings tab then Printer settings > Printing preferences.

Under Mac OS, select Configuration then Printer settings > Configure printer settings >
Printing preferences.

Select one of the following options.

e Select Automatic to let the printer determine which type of file it is receiving. This is the default
setting; it works for most software applications. You should not normally need to change it.

e Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going
through a printer driver.

e Select PDF only if you are sending a file of that type directly to the printer, without going
through a printer driver (PostScript printers only).

e Select PostScript only if you are sending a file of that type directly to the printer, without going
through a printer driver (PostScript printers only).

e Select TIFF only if you are sending a file of that type directly to the printer, without going
through a printer driver (T1200 PS only).

e Select JPEG only if you are sending a file of that type directly to the printer, without going
through a printer driver (T1200 PS only).

You can change the graphic language setting from the front panel. Select the Setup menu icon ,

then Printing preferences > Select graphic language. Select the desired option and press the OK
key to set the value.

B NOTE: If the graphic language is set from the HP Utility, it overrides the front panel setting.
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e General advice

° Load a roll onto the spindle

° Load a roll into the printer

° Unload a roll

° Load a single sheet

° Unload a single sheet

e View information about the paper

° Paper presets

° Printing paper info

° Move the paper
° Maintain paper

e Change the drying time

° Turn the automatic cutter on and off

° Feed and cut the paper
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General advice

/\ CAUTION: Before starting a paper loading process, ensure you have enough room around the printer,
both in front and behind.

/A CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

/A CAUTION: All paper must be 11 inches (28 cm) or longer. A4 and letter paper cannot be loaded
landscape.

X TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

/A CAUTION: Keep the basket closed throughout the loading process.
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Load a roll onto the spindle

1. Open the roll cover.

)

2. Remove the black end of the spindle from the printer, then the blue end.

/A CAUTION: Be sure to remove the black end first. Removing the blue end first could damage the
black end.

A WARNING! Do not insert your fingers into the spindle supports during the removal process.

3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to
mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper
stop from the end of the spindle.
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4. Ifyourroll has a three-inch cardboard core, ensure that the core adaptors (available as accessories)
have been installed. See Accessories on page 135.

5. Ifthe roll is long; rest the spindle horizontally on a table and load the roll on the table.

X TIP:  You may need two people to handle a large roll.

6. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the
spindle showing the correct orientation.

Bf NOTE: From the back of the printer, the blue stopper is inserted into the right-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.

7. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

8.  Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.
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If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls
of different paper types on different spindles. Extra spindles are available for purchase, see
Accessories on page 135.
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Load aroll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle
on page 35.

Bf NOTE: If you have a T1200 series printer, the first three steps below are optional: you can start with
step 4. However, in this case the printer will not keep track of the length of the roll, and will print no
barcode on the roll when it is next unloaded. So you are recommended to follow all the steps, starting
with step 1, unless you have turned off the Printing paper info option. See Printing paper info

on page 45.

1. From the front panel, select the Paper menu icon .

2. Select Paper load.

Paper

~ load

® Paper unload

M Select active roll
»Yiew paper source

H Change loaded paper type
® Paper types list

-
e Mre nAaner J

3.  Select the roll that you want to load.

Paper load
e | Oad roll 1

> Load roll 2
= Load sheet

4. If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.
In the T1200 series only, if you start to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn
to the standby position, so that it can be printed on again without reloading whenever required.

Bf NOTE: If atany time you open a roll cover while that roll is in the standby position, the roll will be
automatically unloaded, and you will have to reload it the next time you want to print on it.

5. Open the roll cover, if it is not already open.

6.  You should stand behind the printer when loading the T1200's lower roll (roll 2). You may stand
behind or in front of the printer when loading the upper roll (roll 1), or when loading a roll into the
T770.

/A CAUTION: If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of the
printer may cause back pain or other physical problems.
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7. Rest the spindle's black end on the left side roll holder. Do not put the end completely into the roll
holder.

i
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8. Rest the blue end of the spindle on the right side roll holder.

/<

9.  With both hands, push the spindle into both roll holders at the same time.

10. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll),
pull the paper slightly and cut a straight edge.
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11. Insert the edge of the paper into the printer.

A WARNING! Do not push your fingers inside the printer's paper path.

%

X TIP:  When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so,
the printer beeps and the front panel asks you to remove the paper.
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12. Rollthe paper into the printer until you feel resistance and the paper flexes slightly. When the printer
detects the paper, it feeds it in automatically.

13. Ifthe leading edge of the paper has a barcode, the printer reads and then cuts off the barcode; you
should remove and discard the cut strip of paper.
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14. If the leading edge of the paper has no barcode, the front panel prompts you to select the paper
category and type.

Select paper category
» Bond and Coated Paper

» Fhioto Faper

»Film

» Technical Paper

» Backlit material

e Self-Adhesive material

X TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driveron page 145.

15. If the Printing paper info option is enabled, the front panel may ask you to specify the length of
the roll. See Printing paper info on page 45.

16. The printer checks the alignment and measures the width, then the front panel prompts you to
close the roll cover.

If the roll is not correctly aligned, follow the instructions on the front-panel display.

Ef NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper
cannot be loaded successfullyon page 144.

Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow
the appropriate procedure as described below.

Quick procedure with paper on the roll (T1200 series only)

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically.

Bf NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know
the length of the roll when it is next loaded. See Printing paper infoon page 45.

NOTE: If you open the cover of roll 1 while a sheet is loaded, the sheet is also unloaded.

Paper menu procedure with paper on the roll

If there is paper on the roll, you can unload it from the front panel.

1. select the Paper menu icon .
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4.

Select Unload paper.

Faper
Faper load (-

H Faper unload

M Select active roll

> Yiew paper source

®H Change loaded paper type
E Paper types list

e Mre haner

EE

Select the roll that you want to unload.

Paper unload

» Unload roll 2
» Unload sheet

You may need to open the roll cover.

Roll out of paper procedure

If the end of the paper is no longer attached to the core, use the following procedure.

1.

If you have already started the unload process, press the Cancel key on the front panel to cancel
that procedure.

Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the
printer is recommended. You may need to open the roll cover.

Lower the blue lever.

If the front panel displays a warning message, press the OK key to clear it.

Load a single sheet

ENWW

1.

2.

When using a T1200 series printer, ensure that the cover of roll 1 is closed. If it is opened while a
sheet is loaded, the sheet will be immediately unloaded.

At the front panel, select the Paper menu icon .
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3. Select Paper load.

Faper
Paper load

E Faper unload

E Select active roll
mYiewW paper source

E Change loaded paper type
E Paper types list

b Mrve maner =l

4. Select Load sheet.

Paper load

e Load roll 1
 Load roll 2
e Load

5. Ifaroll is already loaded, you have to wait while it is automatically unloaded. In the T1200 series
only, the roll is not unloaded, but withdrawn to the standby position, so that it can be printed on
again without reloading as soon as the sheet paper has been unloaded.

Bf NOTE: If atany time you open a roll cover while that roll is in the standby position, the roll will be
automatically unloaded, and you will have to reload it the next time you want to print on it (T1200
series only).

6.  Select your paper category and type.

select paper category
» Bond and Coated Faper

= Fhoto Faper

»Film

» Technical Paper

> Backlit material

e Self-Adhesive material

X TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driveron page 145.
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7. When prompted by the front panel, insert the sheet into the cut-sheet slot on the right side of the
printer.

Load your sheet aligned with the load line and insert until the paper will not continue; with thicker
sheets, you feel resistance.

/A WARNING! Do not push your fingers inside the printer's paper path.

8. Press the OK key on the front panel to feed the paper into the printer. Guide the sheet into the
printer; this is especially important with thicker papers.

9. The printer checks the alignment and measures the sheet.

Bf NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

10. If the length of the sheet is more than 600 mm (23 in), the front panel prompts you to check that
the rear of the sheet is hanging backwards over the roll cover (and not forwards over the printer
window).

11. If the sheet is not correctly aligned, you may be asked to correct the alignment. Please follow the
instructions on the front-panel display.

Bf NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper
cannot be loaded successfullyon page 144.

Unload a single sheet
To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.

To unload a sheet without printing on it, use the following procedure.

1. Atthe front panel, select the Paper menu icon .
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2. Select Unload paper.

Faper
Faper load =

Faper unload
B Select active roll

»Yiew paper source
E Change loaded paper type
E Paper types list

b Mrve maner =l

3. Select Unload sheet.

Paper unload
» Unload roll 1
» Unload roll 2

e nload :

The sheet unloads out of the front of the printer, either catch it manually or allow it to fall in the
basket.

View information about the paper

To view the loaded paper information, press the View information key @ or D on the front panel. By

pressing this key repeatedly, you can see information about all loaded papers: roll and sheet for the
T770 series; roll 1, roll 2 and sheet for the T1200 series.

You can also select the Paper menu icon and then View loaded paper. By pressing the Up or
Down key, you can see information about all loaded papers.

The following information is displayed on the front panel:

e Roll or sheet status

e  Paper type you have selected

e  Width of the paper in millimeters (estimated)

e Length of the paper in millimeters (estimated)

e  Color calibration status

e Paper advance calibration status

If no paper is loaded, the message Out of paper is displayed.

The same information is displayed in the HP Utility for Windows (Overview tab > Supplies Status tab),
the HP Utility for Mac OS (Information group > Printer Status > Supplies Details) and the Embedded
Web Server (upper-right corner).

Ef NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 162.
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Paper presets

Each supported paper type has its own characteristics. For optimum print-quality, the printer changes
the way it prints on each different paper type. For example, some may need more ink and some may
require a longer drying time. So the printer must be given a description of the requirements of each
paper type. This description is called the “paper” preset. The paper preset contains the ICC profile, which
describes the color characteristics of the paper; it also contains information on other characteristics and
requirements of the paper that are not directly related to color. Existing paper presets for your printer
are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer only
contains paper presets for the most commonly used paper types. If you have a paper type for which
your printer has no preset, you cannot select that paper type in the front-panel display.

There are two ways to assign a preset for a new paper type.

e Use an HP factory paper preset by selecting the closest category and type in the front panel or the
HP Utility, see The paper type is not in the driver on page 145.

Ef NOTE: Colors may not be accurate. This method is not recommended for high-quality prints.

e Download the correct paper preset from: htip://www.hp.com/go/T770/paperpresets/ or
http://www.hp.com/go/T1200/paperpresets/.

Bf NOTE: HP provides presets for HP paper types only. If you do not find the paper preset you want
on the Web, you may find that it has been added to the latest firmware for your printer. You can
check the firmware release notes for information, see Update the firmwareon page 131.

Printing paper info

Enable the Printing paper info option to record the printer’s estimate of the remaining roll length, paper
width and type. The information is a combination of barcode and text that is printed on the leading edge
of the roll when the paper is unloaded from the printer.

138 feet (42.1 m.) of 42 inch (1067 mm.) Photo Gloss Paper

= NOTE: The paper-length estimate is available only if the printer registered the amount of paper that
was on the roll when you loaded it. To provide this information to the printer, specify the roll length on
the front panel when loading the paper, or load a roll that has the paper-data barcode printed on it.

NOTE: The barcode and text are printed on the roll only when the loading and unloading processes
are started from the front panel's Paper menu.

NOTE: This option can be expected to work only with papers that are completely opaque. It may fail
with transparent or translucent papers.

To enable the Printing paper info option, go to the front panel and select the Setup menu icon ,

then select Printing preferences > Paper options > Enable printing paper info.

Move the paper

If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel.
You may want to do this in order to have more or less white space between the last print and the next
one.
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To move the paper, select the Paper menu icon and then Move paper.
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Mowve paper

Press 4 to rewind paper.
Fress ¢ to advance paper.

Fress i to continue.

You can move the paper forwards by pressing the Up key on the front panel, or backwards by pressing
the Down key. When the paper is positioned as you want it, press the OK key.

Maintain paper
To maintain paper quality, follow the recommendations below.
e Store rolls covered by another piece of paper or cloth
e  Store cut sheets covered and clean or brush them before loading them in the printer
e Clean input and output platens

e Always keep the window of your printer closed

B NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 162.

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints
where time is of higher importance or when you need to be sure ink is dry before handling.

Select the Setup menu icon , then Print retrieval > Select drying time. You can select:

e Extended, to set a longer than recommended time to ensure ink is completely dry
e Optimal, to set the default and recommended time for your selected paper (this is the default setting)
e Reduced, to set a shorter than recommended time when quality is of lower importance

e None, to disable the drying time and remove your print as soon as it finishes printing

/A CAUTION: Iftheink is not dry when the print is removed it could leave ink in the output tray and marks
on the print.

Bf NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right
away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts
the paper and then performs the printhead maintenance. However, if the dry time is greater than zero,
the printer does not cut the paper until after the printhead maintenance has completed, even if you press
the Form feed and cut key ‘L_js]

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off;

e From the HP Utility for Windows, select the Settings tab and change the Cutter option in Printer
Settings > Advanced.

e From the HP Utility for Mac OS, select Configuration > Printer Settings > Advanced and change
the Cutter option.
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e From the Embedded Web Server, select the Setup tab, then Printer Settings > Advanced, and
change the Cutter option.

®  From the front panel, select the Setup menu icon , then Print retrieval > Enable cutter and
change the cutter option.

The default setting is On.

Bf NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the
paper on loading, unloading and switching between rolls.

X TIP: To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper
on page 47.

Feed and cut the paper

If you press the Form feed and cut key‘@on the front panel, the printer advances the paper and makes

a straight cut across the front edge. There are several possible reasons why you might want to do
this.

e To trim the leading edge of the paper if it is damaged or not straight.
e Tofeed and cut the paper when the automatic cutter has been disabled.

e To cancel the waiting time and print the available pages immediagely, if the printer is waiting to
nest more pages (T1200 series only).

B NOTE: The printheads are serviced after each print, and the paper cannot be cut until the process
completes, so you may notice a delay.

/A CAUTION: Remove the cut piece from the output tray. If strips or short prints are left in the output tray
the printer could jam.

[ >

» N

Bf NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched

on page 162.

X TIP:  To move the paper without cutting it, see Move the paperon page 45.
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6 Working with two rolls (T1200 series
only)

e The uses of a multiroll printer

° How the printer allocates jobs to paper rolls
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The uses of a multiroll printer

A multiroll printer can be useful in several different ways:
e The printer can automatically switch between different paper types according to your needs.

e The printer can automatically switch between different paper widths according to your needs. This
enables you to save paper by printing smaller images on narrower paper.

e Ifyou load two identical rolls into the printer, you can leave it printing unattended for a long time,
because it can switch from one roll to the other automatically when the first is exhausted. See
Unattended printing/overnight printing (T1200 series only) on page 66.

There are two concepts to help you when working with multiple rolls.

e The active roll is the roll that is currently loaded and will be printed on by default unless the printer
has some reason to switch rolls. To change the active roll, select the Paper menu icon ,
then Select active roll.

e A protected roll is protected from use unless the roll number or its paper type are specifically
requested. See Roll protection (T1200 series only) on page 66.

The current status of both rolls is shown on the front panel's status screen.

Ready

@m(m UT OF paper
18®)

%HP Coated Paper

TR A mrHnll
http:/71592.168.1.1

How the printer allocates jobs to paper rolls

When you submit a print job from the Embedded Web Server or the printer driver, you can specify (using
the Paper type or Type is option) that you want it to be printed on a particular paper type; you can even
specify (using the Paper source, Source is or Paper Feed option) that you want it to be printed on a
particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also look for a paper
roll large enough to print the image without clipping.

e If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy.
See Roll switching options on page 22.

e If just one of the rolls is suitable for the job, it will be printed on that roll.

e Ifneitherroll is suitable for the job, it will be held in the job queue with the status “On hold for paper”,
or printed on an unsuitable roll, depending on the paper mismatch action. See Paper mismatch
action on page 22.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the
printer, and on which rolls.
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Here are some settings that might be used in typical situations:
o  With different paper types loaded:

° Type is: select the paper type you require

° Source is: Automatically select / Predetermined

° Roll switching policy: doesn't matter

e  With different paper widths loaded:
° Type is: Any
° Source is: Automatically select / Predetermined

° Roll switching policy: Minimize paper waste

¥ TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper
economicallyon page 64.

e  With identical rolls loaded:
o Typeis: Any
° Source is: Automatically select / Predetermined

° Roll switching policy: Minimize roll changes
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7/ Printing

e Create a print job

° Select print quality

e Select paper size
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e Select margins options

° Print with shortcuts

e Print on loaded paper

° Rescale a print

° Change the treatment of overlapping lines

° Preview a print
° Print a draft

° High-quality printing

° Print in gray shades

e  Print with no margins (T1200 series only)

° Print with crop lines (T1200 series only)

e Reprint last printed job

° Use paper economically

e Nest jobs to save roll paper (T1200 series only)

° Use ink economically

e Roll protection (T1200 series only)

° Unattended printing/overnight printing (T1200 series only)
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Create a print job

In order to print something, you must send it to the printer. This constitutes a print job, which is entered
into the printer's print queue. There are two main ways of sending a print job to the printer:

e To print directly from a program, use the program's Print command as usual. When you select your
HP Designjet printer, the printer driver is invoked to send your job to the printer.

e If you have afile that is already in a supported graphical format, you can use the Embedded Web
Server to send it directly to the printer without going through a printer driver (see below).

Using the Embedded Web Server to print files (T1200 series only)

From the HP Utility, select Job Center > Submit Job. From the Embedded Web Server, select the

Main tab and then Submit job. You will see the window below.
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Press the Add files button to choose the files from your computer that you want to print. The files must
be in one of the following formats:

e PDF (T1200 PS only)

e PostScript (T1200 PS only)
e TIFF (T1200 PS only)

e JPEG (T1200 PS only)

e HP-GL/2

e RTL

NOTE: When you print to a file, the file should be in one of the above formats, but its name may have
an extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and they will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need.
Each option has explanatory text on the right, so that you can understand the behavior of each setting.
Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job
contains no setting, the setting in the printer will be used.
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Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed,
while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you
can also select Economode, which uses a lower rendering resolution and consumes less ink. It
therefore increases printing speed even further, but reduces print quality. Economode can be selected
only from the custom options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum
detail. See High-quality printing on page 61.

NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom
Print Quality Options dialog box (select Custom options and then Settings). In the Mac OS Print dialog,
it is displayed in the Summary panel.

You can select print-quality options in the following ways:

e Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
If you select Standard Options, you will see a simple slider with which you can select speed or
quality. If you select Custom Options, you will see the more specific options described above.

e Inthe Mac OS Print dialog (T770, T1200): go to the Paper/Quality panel and look at the Quality
Options section. If you select Standard quality options, you will see a simple slider with which you
can select speed or quality. If you select Custom quality options, you will see the more specific
options described above.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): go to the Paper/Quality
panel and look at the Quality Options section. If you select Standard quality options, you will see
a simple slider with which you can select speed or quality. If you select Custom quality options,
you will see the more specific options described above.

e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Image Quality
panel. If you select Standard quality options, you will see a simple slider with which you can select
speed or quality. If you select Custom quality options, you will see the more specific options
described above.

e Onthe Embedded Web Server's Submit Job page (T1200 series): select Basic settings >
Print quality. If you then select Standard options, you can choose between Speed and
Quality. If you select Custom options, you will see the more specific options described above.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print
quality.

Bf NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the
front panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has already
received (even if they have not started to print yet).

Select paper size

ENWW

The paper size can be specified in the following ways.
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B NOTE: The paper size specified here should be the paper size in which the document was created.
It is possible to rescale the document to a different size for printing. See Rescale a printon page 58.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select your paper size from
the Document Size list.

e Inthe Mac OS Page Setup dialog: select your printer from the Format for list, then select your
paper size from the Paper Size list.

Bf NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e Onthe Embedded Web Server's Submit Job page (T1200 series): select Advanced
settings > Paper > Page size > Standard.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Paper

options > Select paper size.
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Bf NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front
panel.

Custom paper sizes

To choose a non-standard paper size not shown in the list of paper sizes:
e Under Windows, there are two different ways:

° In the driver dialog, click the Custom button in the Paper/Quality tab, then specify the name
and the dimensions of your new paper size, then click Save to save your new paper size. To
see your new custom size in the list of custom sizes, you need to exit the printer properties,
then reenter them (and use the More button if necessary).

Bf NOTE: The driver will not allow you to create a paper size whose width exceeds its length.

0 From the Start menu, select Printers and Faxes, then from the File menu select Server
Properties. In the Forms tab, check the Create a new form box, specify the name and
dimensions of the new form, then click Save Form.

e Under Mac OS: select Paper Size > Manage Custom Sizes in the Page Setup dialog.

B NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e Onthe Embedded Web Server's Submit Job page (T1200 series): select Advanced
settings > Paper > Page size > Custom.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the
paper (increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in
several ways.

e Inthe Windows driver dialog: select the Paper/Quality tab and then the Margins/Layout button.
e Inthe Mac OS Print dialog (T770, T1200): select the Margins/Layout panel.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): select the Margins/
Layout panel.
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In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Finishing panel
and then Layout.

On the Embedded Web Server's Submit Job page (T1200 series): select Advanced
settings > Paper > Layout/Margins.

You will then see at least some of the following options.

Bf NOTE: UnderMac OS, the available margins options depend on the paper size selected. For instance,
for borderless printing you must select a paper size name that includes the words “no margins”.

Standard. Your image will be printed on a page of the size you have selected, with a narrow margin
between the edges of the image and the edges of the paper. The image should be small enough
to fit between the margins.

Oversize. Your image will be printed on a page slightly larger than the size you have selected. If
you cut off the margins, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper.

Clip Contents By Margins. Your image will be printed on a page of the size you have selected,
with a narrow margin between the edges of the image and the edges of the paper. In this case, if
the image is the same size as the page, the printer assumes that the extreme edges of the image
are either white or unimportant, and do not need to be printed. This may be useful when your image
already contains a border.

Borderless. Your image will be printed on a page of the size you have selected, with no margins.
The image is slightly enlarged to ensure that no margin is left between the edges of the image and
the edges of the paper. If you select Automatically by Printer, this enlargement is done
automatically. If you select Manually in Application, you must select a custom page size slightly
larger than the page on which you intend to print. See also Print with no margins (T1200 series
only) on page 62.

Print with shortcuts

The printer driver provides many options that can be set to different values when printing a particular
job. A printing shortcut stores the values of all these options that are appropriate for a particular kind of
job, so that you can set them all with a single click. Some settings (such as paper size, paper source
and orientation) may be overridden by the values provided by your application.

To use a shortcut, select the Printing Shortcuts tab in the Windows driver dialog.

Bf NOTE: Shortcuts are available only under Windows.
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You can see a list of available shortcuts; select the one that matches the kind of job you want to print.

The driver options are now adjusted to suit your job. You can either print immediately, or examine the
settings to check that you agree with them. If you like, you can select a shortcut and then change some
of its settings manually.

X TIP: Check at least the settings that you can see in the Printing Shortcuts tab: the document size,
orientation, etc.

The Factory Defaults shortcut contains the printer's default settings. When you click on it, it sets all
options to their default values.

Printing shortcuts can be customized to your particular needs. To create your own shortcut:
1.  Select the shortcut that comes closest to satisfying your requirements.

2. Change any value in the Printing Shortcuts tab and/or other tabs.
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3. Save the new printing shortcut.

If you decide later that you no longer want a shortcut, you can delete it.

Print on loaded paper

To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your
printer driver.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select Any in the Paper Type
drop-down list.

e Inthe Mac OS Print dialog (T770, T1200): select the Paper/Quality panel, then select Any in the
Paper Type drop-down list.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): select the Paper/Quality
panel, then select Any in the Paper Type drop-down list.

e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Image Quality
panel, then select Any in the Paper Type drop-down list.

Bf NOTE: Any is the default Paper Type selection.

Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful:

e If your software does not support large formats

e Ifyourfile is too large for the printer's memory—in this case, you can reduce the paper size in your
software and then scale it up again using the front-panel option
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You can rescale an image in the following ways:
e Inthe Windows driver dialog: go to the Features tab and look at the Resizing Options section.

o The Print document on option adjusts the image size to the paper size you have selected.
For example, if you have selected ISO A2 as the paper size and you print an A3-sized image,
it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a
larger image to fit the A4 size.

° The % of actual size option enlarges the printable area of the original paper size (the page
minus the margins) by the percentage indicated, then adds the margins to create the output
paper size.

e Inthe Mac OS Print dialog (T770, T1200): select the Paper Handling panel, then Scale to fit
paper size, and select the paper size to which you want to scale the image. If you want to increase
the size of the image, make sure that the Scale down only box is unchecked.

e Inthe Mac OS Print dialog (PostScript printers): select the Finishing panel, then Print
document on, and select the paper size to which you want to scale the image. For example, if you
have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the
A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.
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e Onthe Embedded Web Server's Submit Job page (T1200 series): select Advanced
settings > Resizing.

° The Standard and Custom options adjust the image size to the standard or custom paper
size you have selected. For example, if you have selected ISO A2 as the paper size and you
print an A4-size image, it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected,
the printer reduces a larger image to fit the A3 size.

° The % of actual size option enlarges the printable area of the original paper size (the page
minus the margins) by the percentage indicated, then adds the margins to create the output
paper size.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Paper

options > Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet,
otherwise the image will be clipped.

Change the treatment of overlapping lines

Bf NOTE: This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:
e Off: where the lines cross, only the color of the top line is printed. This is the default setting.
e  On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and select the Setup menu icon , then Printing

preferences > HP-GL/2 options > Enable merge. You can set the merge option from your software
in some applications. Settings in your software override the front-panel settings.
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Preview a print

Previewing a print on the screen allows you to check the layout of the print before printing, which may
help you to avoid wasting paper and ink on a bad print.

To preview a print under Windows, you have the following options:
o Use your application's print preview option.

° Check the Show preview before printing option, which you can find in the driver's Printing
Shortcuts tab, Paper/Quality tab and Features tab. The preview may be provided in different
ways, depending on your printer and printer driver.

To preview a print under Mac OS, you have the following options:
° Use your application's print preview option.

° Click the Preview button at the bottom of the Print dialog box. This is the basic print preview
provided by Mac OS.

° If you are using the PostScript driver for the T1200 PS printer, check the Show print
preview option, which you can find in the driver's Printing dialog, in the Finishing panel. This
preview is provided by the Embedded Web Server and will appear in a Web browser window.

° If you are using the PCL driver, click the PDF button at the bottom of the Print dialog box, then
click HP Print Preview. This provides a preview with more features, such as the ability to
change paper size, paper type and print quality, and to rotate the image.

Bf NOTE: HP Print Preview is not available if you are using Adobe InDesign, Adobe lllustrator,
Adobe Reader or Apple Aperture.

To preview a print using the Embedded Web Server, select Basic settings > Hold for preview.
This preview is available from the T770 HD printer and the T1200 printer series.

Print a draft

You can specify fast draft-quality printing in the following ways:

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme left ('Speed').

In the Mac OS Print dialog (T770, T1200): go to the Paper/Quality panel and move the print-
quality slider to the extreme left ('Speed').

In the Mac OS X 10.5 PostScript Print dialog (PostScript printers): go to the Paper/Quality
panel and move the print-quality slider to the extreme left ('Speed').

In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Image Quality
panel and move the print-quality slider to the extreme left ('Speed').

On the Embedded Web Server's Submit Job page (T1200 series): select Basic settings >
Print quality > Standard options > Speed.

Using the front panel: select the Setup menu icon , then Printing preferences > Print

quality > Select quality level > Fast.
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You can specify even faster draft-quality printing by using Economode, as follows. This is intended
mainly for documents containing only text and line drawings.

e Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Select Custom Options, then set the quality level to Fast and check the Economode box.

e Inthe Mac OS Print dialog (T770, T1200): go to the Paper/Quality panel and set the quality
options to Custom, then set quality to Fast and check the Economode box.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): go to the Paper/Quality
panel and set the quality options to Custom, then set quality to Fast and check the Economode
box.

e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Image Quality
panel and set the quality options to Custom, then set quality to Fast and check the Economode
box.

e Onthe Embedded Web Server's Submit Job page (T1200 series): select Basic settings >
Print quality > Custom. Set Quality level to Fast, and Economode to On.
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®  Using the front panel: select the Setup menu icon , then Printing preferences > Print

quality > Enable economode.

Bf NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

High-quality printing
You can specify high-quality printing in the following ways:

e Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme right ('Quality').

e Inthe Mac OS Print dialog (T770, T1200): go to the Paper/Quality panel and move the print-
quality slider to the extreme right ('Quality").

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): go to the Paper/Quality
panel and move the print-quality slider to the extreme right (‘Quality").

e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Image Quality
panel and move the print-quality slider to the extreme right (‘Quality").

e Onthe Embedded Web Server's Submit Job page (T1200 series): select Basic settings >
Print quality > Standard options > Quality.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print

quality > Select quality level > Best.

Bf NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom
Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum
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Detail option. This option is available only if you are printing on glossy paper and you have selected
Best print quality.

e Inthedriver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality
options, then check the Maximum Detail box.

e Onthe Embedded Web Server's Submit Job page (T1200 series): select Basic settings >
Print quality > Custom. Set Quality level to Best, and Maximum detail to On.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Print

quality > Enable maximum detail.

Ef NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase
the amount of ink used.

Print in gray shades

You can convert all colors in your image to shades of gray in the following ways:
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e In your application program: many programs provide this option.

e Inthe Windows driver dialog: go to the Color tab and look at the Color Options section.
Select Print in Grayscale. You can also select Print in pure black and white if you want only
black and white, without gray shades.

e Inthe Mac OS Print dialog (T770, T1200): go to the Color Options panel and select
Grayscale from the Mode drop-down list. You can also select Pure Black and White if you want
only black and white, without gray shades.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): go to the Color Options
panel and select Grayscale from the Mode drop-down list. You can also select Pure Black and
White if you want only black and white, without gray shades.

e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Color Options
panel and select Print In Grayscale. You can also select Print in Pure Black and White if you
want only black and white, without gray shades.

e Onthe Embedded Web Server's Submit Job page (T1200 series): select Color, then set Color/
Grayscale to Print In Grayscale. You can also select Pure Black and White if you want only
black and white, without gray shades.

Print with no margins (T1200 series only)

Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done
only on rolls of glossy paper.

In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink
deposited outside the paper is absorbed by the sponge situated in the platen.

You can request printing with no margins in the following ways:

e Inthe Windows driver dialog: select the Paper/Quality tab and press the Margins/Layout
button. Then select Borderless.

e Inthe Mac OS Page Setup dialog (T1200): select a paper size name that includes the words “no
margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

Bf NOTE: If your application offers no Page Setup dialog, please use the Print dialog.
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e Inthe Mac OS X 10.5 PostScript Page Setup dialog (T1200 PS): select a paper size name that
includes the words “no margins”. Then, in the Print dialog, select Margins/Layout >
Borderless.

B NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e Inthe Mac OS X 10.4 PostScript Page Setup dialog (T1200 PS): select a paper size name that
includes the words “no margins”. Then, in the Print dialog, select Finishing > Layout >
Borderless.

5 NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e Onthe Embedded Web Server's Submit Job page: select Advanced settings > Paper >
Layout/Margins > Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:

e Automatically by printer means that the printer automatically enlarges your image slightly
(normally by a few millimeters in each direction) in order to print over the edges of the paper.

e Manually in application means that you must enlarge the image yourself in your application, and
select a custom paper size that is slightly larger than the actual paper size.

NOTE: If the first print job after loading paper is a borderless job, the printer may trim the leading edge
of the paper before printing.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure
that the print is borderless. It then cuts the paper again so that no residual part of the image is included
in the next print. However, if the job is cancelled, or if there is white space at the bottom of the image,
only a single cut is made.

with crop lines (T1200 series only)

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print
crop lines with individual jobs in the following ways:

e Inthe Windows driver dialog: select the Features tab, then Crop lines.
e Inthe Mac OS Print dialog: select the Finishing panel, then Crop lines.

e Onthe Embedded Web Server's Submit Job page: select Advanced settings > Roll
options > Enable crop lines > Yes.

Alternatively, you can choose to print crop lines with all jobs by default:

e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Use crop
lines when printing > On.

®  Using the front panel: select the Setup menu icon , then Printing preferences > Paper >
Enable crop lines > On.

To print crop lines with nested jobs (see Nest jobs to save roll paper (T1200 series only)
on page 64), you must select a different option:

e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Use crop
lines when nest is enabled > On.

®  Using the front panel: select the Setup menu icon , then Job management > Nest

options > Enable crop lines > On.
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Reprint last printed job

You can reprint the last job printed from the front panel. Select the Job management menu icon @]

then Reprint last job.

Ef NOTE: You cannot use this method for PCL3 jobs. To reprint old jobs that are PCL3, you may be able
to use your operating system's printer spooler, if you have already set the spooler to save old jobs. This
facility depends on your operating system.

Use paper economically

Here are some recommendations for making economical use of paper:

e If you are printing relatively small images or document pages, you can use nesting to print them
side by side instead of one after another. See Nest jobs to save roll paper (T1200 series only)

on page 64.
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e You may be able to save some roll paper by using the following options:

° In the Windows driver dialog: select the Features tab and then Remove top/bottom blank
areas and/or Rotate by 90 degrees.

° In the Mac OS Print dialog (T770, T1200): select the Finishing panel, then Remove Top/
Bottom Blank Areas.

° In the Mac OS PostScript Print dialog (PostScript printers): select the Finishing panel,
then Remove Top/Bottom Blank Areas and/or Rotate by 90 degrees.

° On the Embedded Web Server's Submit Job page (T1200 series): select Advanced
settings > Roll options > Remove top/bottom blank areas and/or Rotate.

e If you check the print preview on your computer before printing, you can sometimes avoid wasting
paper on prints containing obvious mistakes. See Preview a print on page 60.

Nest jobs to save roll paper (T1200 series only)

Nesting means automatically printing images or document pages side by side on the paper, rather than
one after the other. This is done to avoid wasting paper.

1. Direction of paper flow

2. Nesting off
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3. Nesting on

4. Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true:
e The printer is loaded with roll paper, not sheet paper.

e The printer's Nest option is not turned off. See Turn nesting on and off (T1200 series only)
on page 22.

What pages can be nested?

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or
unless there are too many of them to fit into the remaining length of the roll. A single group of nested
pages cannot be split between two rolls.
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Which pages qualify for nesting?

In order to be in the same nest, the individual pages must be compatible in all of the following ways:

e All pages must have the same print quality setting (Economode, Fast, Normal or Best).
e The Maximum Detail setting must be the same on all pages.

e The Layout/Margins setting must be the same for all pages.

e The Mirror Image setting must be the same for all pages.

e The Rendering Intent must be the same for all pages.

e  The Cutter setting must be the same for all pages.

e The color adjustment settings must be the same for all pages. See Color adjustment options
on page 73.

e Pages must be all color, or all grayscale: not some in color and some in grayscale.

e All pages must be in one or other of the following two groups (the two groups cannot be mixed in
the same nest):

o HP-GL/2, RTL
° PostScript, PDF, TIFF, JPEG
e JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some
cases.
How long does the printer wait for another file?

So that the printer can make the best nest possible, it waits after a file has been received to check
whether a subsequent page will nest with it or with pages already in the queue. This waiting period is
the nest wait time; the factory default nest wait time is two minutes. This means that the printer waits
for up to two minutes after the last file is received before printing the final nest. You can change this

waiting time from the printer's front panel: select the Setup menu icon , then Job management

options > Nest options > Select wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel. You
can print the nest (cancel the nest wait) by pressing the Form feed and cut key.
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Use ink economically

Here are some recommendations for making economical use of ink.

e Fordraft prints, use plain paper and move the print-quality slider to the left end of the scale
('Speed'). For further economy, select custom print quality options, then select Fast and
Economode.

e Clean the printheads only when needed, and clean only those printheads that need cleaning.
Cleaning the printheads can be useful, but it uses a small amount of ink.

e Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printheads.

e Wide prints make more efficient use of ink than narrow prints, because printhead maintenance
uses some ink, and its frequency is related to the number of passes made by the printheads.
Therefore, nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper
(T1200 series only) on page 64).
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Roll protection (T1200 series only)

If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll number
or the paper type loaded on the roll. This may be useful, for example, in the following cases.

e To stop people from accidentally printing unimportant jobs on expensive paper.

e To avoid printing on a particular roll when printing from AutoCAD without interacting with the HP
printer driver.

To protect a roll, go to the front panel and select the Setup menu icon , then Printing

preferences > Paper options > Roll protection.

Bf NOTE: If you protect a roll, then later unload the current roll and load a new one, the new roll remains
protected. You are protecting the roll number, not one specific roll of paper. That roll number will remain
protected until you cancel the protection.

X¥ TIP: If you print without specifying a roll number or paper type, you will not be able to print on any
protected roll.

Unattended printing/overnight printing (T1200 series
only)

The HP Designjet T1200 printer series, with multiple rolls, plus robust and consistent image quality, is
perfect for long unattended printing jobs.

Here are some recommendations to help you deal with a long queue of printing jobs.
e Iffeasible, use brand-new long rolls of paper.

e If you want to print on partly-used rolls, you can check the paper type and the remaining length in
the Embedded Web Server or in the front panel, to confirm that you have enough paper to print all
your jobs.

B NOTE: Information on the remaining length is available only if you told the printer the length of
the roll when you loaded it, or if the printer read the length of the roll from the barcode printed on
it.
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e Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically
switch to the other.

e Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may
be put “on hold for paper” if the paper mismatch action is set to Put job on hold (see Paper
mismatch action on page 22).

e Check the ink levels remaining in your ink cartridges.

e  When you have submitted your print jobs, you can use the Embedded Web Server from a remote
location to monitor their status.

e Drying time should be set to Optimal.
®  Select the Setup menu icon , then Printing preferences > Paper options > Roll switching
options > Minimize roll changes or Use roll with less paper.

We recommend the following settings, depending on the paper type and what kind of prints you are
making.
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Table 7-1 Recommended settings for unattended printing

Print type Print mode MaxDetail Optimized for Drying time Paper types
Lines Normal Off Lines Optimal Coated, Bond,
Heavyweight
Coated, Glossy
Lines and fills Normal On Lines Optimal Coated, Bond,
Heavyweight
Coated, Glossy
Maps Best On Images Optimal Coated,
Heavyweight
Coated, Glossy
Renderings, Best On Images Optimal Coated,
photographs Heavyweight

Coated, Glossy
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° Introduction

° How colors are represented

° A summary of the color management process

e Color calibration

e Color management from printer drivers

e Color management from printer drivers (PostScript printers)

e Color management from the Embedded Web Server (T1200 series only)

° Color management from the front panel
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Introduction

HP Designjet T770 and T1200 printers have been engineered with advanced hardware and software
features to ensure predictable and dependable results.

e  Color calibration for consistent colors.
e One gray and two black inks provide neutral grays on all paper types.
e The Photo Black ink provides pure blacks when printing on photo papers.

e  Color emulation of other HP Designjet printers.

How colors are represented

All devices that display color use a color model to represent color in numerical terms. Most monitors
use the RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-Yellow-
blacK) color model.

An image can be converted from one color model to another, but in general the conversion is not perfect.
Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents
colors a little differently from another device, even if they use the same color model. However, software
can adjust the colors in an image according to the characteristics of the particular device, using a color
profile of the device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper
type that you use.
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1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and
then (see Color calibration on page 70). In addition, you may wish to calibrate immediately before
a particularly important print job for which color consistency is vital.

2. When printing, select the correct color preset for the paper type you are using.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printheads, inks
and paper type that you are using, and under your particular environmental conditions. After color
calibration, you can expect to get similar prints from any two different printers situated in different
geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of
the following circumstances:

e  Whenever a printhead is replaced

e Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

e  Whenever the environmental conditions (temperature and humidity) change significantly
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You can check the color calibration status of the currently loaded paper at any time by pressing the
View information key on the front panel. The status may be one of the following:

e PENDING: the paper has not been calibrated.

1),

NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is
reset to PENDING.

e OBSOLETE: the paper has been calibrated, but the calibration is now out of date because a
printhead has been replaced, and should be repeated.

e DONE: the paper has been calibrated, and the calibration is up to date.

e DISABLED: this paper cannot be calibrated.

1),

NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent
material.

You can also check the color calibration status by using the HP Utility.
You can start color calibration in the following ways:

e From the HP Utility for Windows: select Color Center > Calibrate paper, and choose the paper
to be calibrated.

e From the HP Utility for Mac OS: select Paper Preset Management from the HP Color Center
group, choose the paper to be calibrated, press the [¢] button and select Calibrate Paper.

®  From the front panel: select the Image Quality Maintenance menu icon , then Calibrate
color.
The calibration process is fully automatic and can be performed unattended after you have loaded paper

of the type you wish to calibrate—which should be A4 or any larger size. The paper on the active roll
will be calibrated; you should ensure that the roll you want to calibrate is active. To change the active

roll, select the Paper menu icon , then Select active roll.
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The process takes about 3—5 minutes and consists of the following steps.

1. A calibration chart is printed, which contains patches of each ink used in your printer.
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2. The chartis allowed to dry for a period of time that depends on the paper type, so that the colors
have time to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for
consistent color printing on that paper type. It also calculates the maximum amount of each ink
that can be applied to the paper.

ENWW Color calibration 71



Q)
cl
o
=
3
Q
>
Q
(@]
D
=
®
>
—

Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that,
when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

e Application-Managed Colors: in this case your application program must convert the colors of
your image to the color space of your printer and paper type, using the ICC profile embedded in
the image and the ICC profile of your printer and paper type.

e Printer-Managed Colors: in this case your application program sends your image to the printer
without any color conversion, and the printer converts the colors to its own color space. The details
of this process depend on the graphics language that you are using.

° PostScript (PostScript printers): the PostScript interpreter module inside the printer
performs the color conversion using the profiles stored in the printer and any additional profiles
sent with the PostScript job. This kind of color management is done when you are using the
PostScript driver and you specify printer color management or when you send a PostScript,
PDF, TIFF or JPEG file directly to the printer through the Embedded Web Server. In either
case you have to select the profiles to use as default (in case the job doesn't specify any) and
the rendering intent to apply.

° Non-PostScript (PCL, RTL, HP-GL/2): the color management is done using a set of stored
color tables. ICC profiles are not used. This method is somewhat less versatile than the
alternatives, but is a little simpler and faster, and can produce good results with standard HP
paper types. This kind of color management is done when you are using a non-PostScript
driver and you specify printer color management, or when you send a PCL, RTL or HP-GL/2
file directly to the printer through the Embedded Web Server.

Bf NOTE: There are only two color spaces that the printer can convert to its own color space
using the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB
and ColorSync if you are using Mac OS.

ColorSync is the Mac OS built-in Color Management System; so, when you select ColorSync,
color management is performed by Mac OS, and it is done based on the ICC profiles of the
specified paper type. ColorSync is available with the PCL3 driver only.

ColorSync can be selected under Mac OS X 10.4 from the Color Options panel: select Use
Embedded (ICC/ColorSync) from the Source Profile drop-down list. Under Mac OS X 10.5,
ColorSync can be selected from the Color Matching panel.

You are recommended to consult the Knowledge Center (see Knowledge Center on page 188) to see
how to use the color management options of your particular application.

To choose between Application-Managed Colors and Printer-Managed Colors:
e Inthe Windows driver dialog: select the Color tab.
e Inthe Mac OS Print dialog: select the Color Options panel.

e In some applications: you can make this choice in the application.

Printer emulation
If you want to print a particular job and to see approximately the same colors that you would get from

printing the same job on a different HP Designjet printer, you can use the emulation mode provided by
your printer.
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Bf NOTE: This option is available only when printing an HP-GL/2, PostScript or PDF job. It will work
correctly only when printing on plain, coated or heavyweight coated paper.

e Inthe Windows HP-GL/2 or PostScript driver dialog: select the Color tab, then Printer
Managed Colors, then select Printer Emulation from the Source Profile list. You can then select
from the Emulated Printer list.

e Inthe Mac OS Print dialog (T770, T1200): select the Color Options panel, then Color
Management > Printer, then select Printer Emulation from the Source Profile list.

e Inthe Mac OS Print dialog (PostScript printers): select the Color Options panel, then select
from the Printer Emulation list.

Color adjustment options

The aim of color management is to print accurate colors. If you perform color management correctly,
then you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:
e If your color management is not working correctly for some reason
e If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color
or in grayscale. If you are printing in pure black and white, there are no color adjustment options.

Printing in color
You can adjust the colors of your print in similar ways under Windows and Mac OS:

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.
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e Inthe Mac OS Print dialog (T770, T1200): select the Color Options panel, select Color from the
Mode list, then press the Adjust button.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): select the Color Options
panel, select Color from the Mode list, then press the Adjust button.

e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Color Options
panel, then Lightness and Hue.

Under either operating system, you will then be able to make adjustments using a lightness slider and
three color sliders.

ENWW Color management from printer drivers 73



Advwanced Lightmess and Coder Balance Adjustments
Lighirass
. 5
50 &0
Coiar B
v [a } Fed
=0 i}
dageeen: [0 F' Gamens
N T &
o [0 — ); B
=0 50 .
o |

e The lightness slider simply makes the whole print lighter or darker.

e The color sliders can be used to fade or emphasize each of the primary colors in the print. The
primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the color
model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can adjust the gray balance of your print in similar ways under Windows and Mac OS:

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

e Inthe Mac OS Print dialog (T770, T1200): select the Color Options panel, select Grayscale
from the Mode list, then press the Adjust button.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): select the Color Options
panel, select Grayscale from the Mode list, then press the Adjust button.
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e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Color Options
panel, then Print in Grayscale, then the Gray balance tab.

Under either operating system, you will then be able to make adjustments using separate controls for
highlights, midtones and shadows.
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Color management from printer drivers (PostScript
printers)
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e The lightness slider simply makes the whole print lighter or darker. This slider is available in the
same window as the other grayscale controls, except under Mac OS X 10.4, where it is available
by selecting Lightness and Hue.

e The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

e The other controls for highlight, midtone and shadow can be used to adjust the gray balance of
highlights, midtones and shadows respectively.

The Reset button restores each control to its default setting.
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This facility is available when printing with the PostScript driver.

HP Professional PANTONE Emulation

ENWW

When you use a named PANTONE color in an image, your application will normally send to the printer
a CMYK or RGB approximation to that color. But the application does not take the printer or the paper
type into account, it merely produces a generic approximation of the PANTONE color, which will look
different on different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the
characteristics of the printer and the paper type. The results look as similar to the original PANTONE
colors as is possible on a given printer using a given paper type. This technology is designed to produce
emulations similar to those set up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally
on by default.

e Inthe Windows PostScript driver dialog: go to the Color tab and select HP Professional
PANTONE Emulation.

e Inthe Mac OS Print dialog: go to the Color Options panel and select HP Professional
PANTONE Emulation.

You can also use the Embedded Web Server to print a swatch book showing emulations of PANTONE
colors as made by your printer, together with a measure of the color difference (AE) between each
emulation and the original PANTONE spot color. So HP Professional PANTONE Emulation not only
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provides the closest match that can be achieved on your printer; it also gives clear information on how
close the emulation is to the original spot color. See Printing PANTONE swatch books on page 78.

Color emulation

Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and CMYK
devices such as presses and printers.

You can set color emulation in the following ways:
e Inthe Windows PostScript driver dialog: select the Color tab, and Printer Managed Colors.

e Inthe Mac OS Print dialog: select the Color Options panel, then select Printer from the Color
Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The
standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide
the most common standards for the different devices.

The options are as follows.

CMYK color emulation

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted
to the printer, because different printers will produce different colors from the same CMYK data. If the
image file you are printing was not created specifically for your HP Designjet printer, it will require some
readjustment, which can be done using one of the following options provided with your printer.

e None (Native): no emulation. The printer will use its default internal conversion from CMYK to
RGB, without following any color standard. This does not imply that results will be bad

e U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations using
U.S. inks under the following printing conditions: 300% total area of ink coverage, negative plate,
coated publication-grade stock.
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e U.S.Web Uncoated 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated
white offset stock.

e U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 350% total area of ink coverage, negative plate, bright
white offset stock.

e U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 260% total area of ink coverage, negative plate,
uncoated white offset stock.

e EuropeISO Coated FOGRAZ27 is designed to produce quality separations for standard ISO 12647
printing under the following printing conditions: 350% total ink coverage, positive film, coated paper.

e Euroscale Uncoated 2 uses specifications designed to produce quality separations using
Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive
plate, uncoated white offset stock.

e Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher
Association for digital proofing of images in the Japanese magazine/advertising market.

e Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper. It
is designed to produce quality separations using 350% total ink coverage, positive film and coated
paper.
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e Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated) paper.
It is designed to produce quality separations using 310% total ink coverage, positive film and
uncoated paper.

e Japan Color 2002 Newspaper uses the Japan Color 2002 for Newspapers specification. It is
designed to produce quality separations using 240% total ink coverage, positive film and standard
newsprint paper.

e JMPA: Japanese standard for offset press.
e Toyo is designed to produce quality separations for Toyo printing presses.

e DIC is designed to produce quality separations for Dainippon Ink Company printing presses.

B NOTE: These options have no effect if the application is defining its own CMYK space, known as
calibrated CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation
Your printer is provided with the following color profiles:

e None (Native): no emulation, for use when the color conversion is done by the application or
operating system, and therefore the data arrive at the printer already color-managed.

e sSRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard space
is endorsed by many hardware and software manufacturers, and is becoming the default color
space for many scanners, printers and software applications.

e ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space
provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

e Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety of
desktop publishing applications. Use this space for files that you plan to display on Apple monitors,
or for working with old desktop publishing files.
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e Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do
print production work with a broad range of colors.

Color management from the Embedded Web Server (T1200
series only)

Submit Job options

When you send jobs to the printer using the Embedded Web Server's Submit Job page, you have the
following color management options.

If you leave an option set to Default, the setting saved in the job will be used. If the job contains no
setting, the front-panel setting in the printer will be used.

T1200 and T1200 PS options
e Color/Grayscale: you can choose to print in color, in shades of gray or in pure black and white.

e Default RGB source profile: you can choose from a selection of RGB source profiles recognized
by the printer.

e Printer emulation: you can choose to emulate a different HP Designjet printer. Default: Off (no
printer emulation).
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T1200 PS options (with PostScript or PDF jobs)

e Default CMYK source profile: you can choose from a selection of CMYK source profiles
recognized by the printer. Default: Europe ISO Coated FOGRA27.

e Rendering intent: you can select the rendering intent.
e Black point compensation: you can turn black point compensation on or off.

e HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation on
or off.

Rendering intent

Rendering intent is one of the settings used when doing a color transformation. As you probably know,
some of the colors you want to print may not be reproducible by the printer. The rendering intent allows
you to select one of four different ways of handling these so-called out-of-gamut colors.

e Saturation (graphics): best used for presentation graphics, charts or images made up of bright,
saturated colors.

e Perceptual (images): best used for photographs or images in which colors blend together. It tries
to preserve the overall color appearance.

e Relative colorimetric (proofing): best used when you want to match a particular color. This
method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will
be printed accurately. The other methods will probably provide a more pleasing range of colors but
do not guarantee that any particular color will be printed accurately. It maps the white of the input
space to the white of the paper on which you are printing.

e Absolute colorimetric (proofing): the same as relative colorimetric, but without mapping the
white. This rendering is also used mainly for proofing, where the goal is to simulate the output of
one printer (including its white point).
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Perform black point compensation

The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the
source space is mapped into the full dynamic range of the destination space. It can be very useful in
preserving shadows when the black point of the source space is darker than that of the destination
space. This option is allowed only when the Relative colorimetric rendering intent is selected (see
Rendering intent on page 78).

Printing PANTONE swatch books

You can use the Embedded Web Server to print a swatch book showing emulations of PANTONE colors
as made by your printer, together with a measure of the color difference (AE) between each emulation
and the original PANTONE spot color.

To print a swatch book, select the Embedded Web Server's Main tab, then HP Professional PANTONE
Emulation. Select the PANTONE stock to emulate, and one or more strips of PANTONE colors that
you want to print. You can select color strips from more than one PANTONE stock. When you have
selected all the colors you want, press the Next button. The next window displays your selection; you
can press Print to print that selection, or Back to change the selection.
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Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by selecting the Image Quality
Maintenance menu icon , then Calibrate color. See Color calibration on page 70.

The other color options in the front panel can all be found by selecting the Setup menu icon ,

then Printing preferences > Color options.

Bf NOTE: These front panel settings can all be overridden by the printer driver or (with the T1200 series)
Embedded Web Server job submission settings.

T770 series and T1200 series options
e Color/Grayscale: you can choose to print in color or in shades of gray. Default: Print in color.

e Select RGB source profile: you can choose from a selection of RGB source profiles recognized
by the printer. Default: SRGB (HP).

e Emulate printer: you can choose to emulate a different HP Designjet printer. Default: Off (no
printer emulation).

¥ TIP: If you have old HP-GL/2 or PostScript files made for a different HP Designjet printer, you
can send them to the printer and use the front panel to turn on the appropriate emulation mode.
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T1200 PS options (with PostScript or PDF jobs)

e Select CMYK source profile: you can choose from a selection of CMYK source profiles
recognized by the printer. Default: Europe ISO Coated FOGRA27.

e Select rendering intent: you can select the rendering intent. Default: Perceptual.
e Black point compensation: you can turn black point compensation on or off. Default: On.

e HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation on
or off. Default: On.
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9 Practical printing examples

° Print a draft for revision with the correct scale

° Print a project

° Print a presentation

° Print and scale from Microsoft Office
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Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1.  Inthe Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to
check the plot size.

B8 Adobe Acrobat Professional - [Using wour T770 or T1200 printer. pdf]
= Be EM Yew [Dooment Commenis Jook fdhvarced indow Heb NES
A 3
§ ~
—
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Wsing your prner
E
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El
—
§ O
i
—-——
| Hix 2657 mm >
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2. Select File > Print and ensure that Page Scaling is set to None.
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Bf NOTE: The page size will not be automatically selected according to the drawing size.

82 Chapter 9 Practical printing examples ENWW



3. Press the Properties button and then select the Paper/Quality tab.
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4.  Choose whatever Document Size and Print Quality you want to use. If you want to define a new
custom paper size, press the Custom button.
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6. Click OK, and check that the print preview in the Print dialog box seems correct.
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Print a project

This section demonstrates how to print a project from Autodesk Design Review, AutoCAD and the
printer's Embedded Web Server.

Using Autodesk Design Review

Autodesk Design Review offers the Use HP Instant Printing option. This needs to be enabled once,
after which it is taken as the default printing option until it is disabled.

Enabling HP Instant Printing from Autodesk Design Review
1. Start Autodesk Design Review and select File > Print.
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2. Inthe Print dialog box, check the Use HP Instant Printing box. You can select your printer and
paper size here, or in the next window.

Print - Bracket30.dwl
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3. Ensure that the printer and paper size are correct, then click OK to start printing.
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Enabling HP Instant Printing from the Batch Print Wizard

1. Make sure you have installed the Batch Print Wizard. Start Autodesk Design Review and select
File > Batch Print Wizard.
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2. Inthe Welcome box, click Next.

Design Review - Batch Prist Wizand
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3.  Select the DWEF files to print, then click Next.
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4.  Use the Shift key if you want to select multiple files to configure. Then click Print Setup, and the
printing configuration will be applied to all the files you have selected..
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5. Inthe Print dialog box, check the Use HP Instant Printing box. You can select your printer and
paper size here, or in the next window.
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6. Ensure that the printer and paper size are correct, then click OK. The paper size is automatically
preselected.
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7. Backin the Choose print settings box, click Next.
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8. Save or start the batch print job.
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Using HP Instant Printing

e Make sure Use HP Instant Printing has been selected. To print, click the Print icon in the toolbar
or select File > Print. Choose your preferred printing settings and click OK.
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e Alternatively, Use HP Instant Printing can be launched directly from its own toolbar icon. In this
case, it starts immediately, using the settings you defined previously.
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Using AutoCAD

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the
model.

Encer new valus for TILEMODE <l>: O Regeneracing layouc.
Command: QUDRANING

2. Click the Plot icon at the top of the window.

3. The Plot window opens.
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4. You can see further options by pressing the circular button in the lower right corner of the window.
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Bf NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD
viewport objects that are sent for printing.

5. Press the Properties button.
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6. Select the Device and Document Settings tab, and press the Custom Properties button.
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7. Inthe Paper/Quality tab, check the Show preview before printing box, and select the paper type
that you intend to use.
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Bf NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection (T1200 series only)on page 66).
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8.  Select the print quality (your own choice between speed and quality of printing).
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9. Ifyou intend to print on roll paper, you must decide where the printer should cut the paper. Press
the Margins/Layout button and select Clip contents by margins.

Layaut snd Marging option
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10. Select the Features tab, then select the Autorotate option. If you have a T1200 series printer,
select the Crop lines option also. Autorotation can help to avoid wasting paper, and the crop lines
will show you where to cut the paper after printing.
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11. Press the OK button and save your configuration changes to a PC3 file.
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12. When you have pressed the OK button in the Plot window, the printer will construct a print preview
(T1200 series only).
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Using the Embedded Web Server to submit files (T1200 series only)

From the HP Ultility or the Embedded Web Server, select Job Center > Submit Job. With some Web
browsers, you will see the window below; with other Web browsers, the mechanism for adding files is
slightly different.
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Press the Add files button (or Choose File, Add another file) to choose the files from your computer
that you want to print. The files must be in one of the following formats:

e PDF (T1200 PS only)
e PostScript (T1200 PS only)
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o  TIFF (T1200 PS only)
o JPEG (T1200 PS only)
e HP-GL2

e RITL

Bf NOTE: When you print to a file, the file should be in one of the above formats, but its name may have
an extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and the project will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need.
Each option has explanatory text on the right, so that you can understand the behavior of each setting.
Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job
contains no setting, the setting in the printer will be used.

Using printer emulation

Printer emulation can be requested by selecting Advanced settings > Color > Color management
> Printer emulation.

You can select Off (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

Using clip contents by margins

You can select this margins option from Advanced settings > Paper > Layout/Margins > Print with
margins > Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper
you have selected. The printer will use the white border for its margins and you will get a page of size
equal to that which is selected in the driver.

Print a presentation

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using AutoCAD
1. Open the AutoCAD file and select a layout.
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2. Click the Plot icon at the top of the window.
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4.  Select the Device and Document Settings tab, and press the Custom Properties button.
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5. Inthe Paper/Quality tab, check the Show preview before printing box, and select the paper type

that you intend to use.
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Bf NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection (T1200 series only)on page 66).

6. Select the print quality (your own choice between speed and quality of printing).

7. Ifyou intend to print on roll paper, you must decide where the printer should cut the paper. Press
the Margins/Layout button and select Clip contents by margins.
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o) 8. If you are using photo or glossy paper, you can select Borderless printing (T1200 series only).
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9. Select the Features tab, then select the Autorotate option. If you have a T1200 series printer,
select the Crop lines option also. Autorotation can help to avoid wasting paper, and the crop lines
will show you where to cut the paper after printing.
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10. Press the OK button and save your configuration changes to a PC3 file.
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11. When you have pressed the OK button in the Plot window, the printer will construct a print preview
(T1200 series only).
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Using Adobe Photoshop

1. Select File > Page Setup > Printer, select your printer and click OK.
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2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, select Printer > Properties > Paper/
Quality > Custom > Paper Size. Enter the width, the length and the name of your custom paper
size. Press the Save and OK buttons.
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3. Select File > Print with Preview. "
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4.  Select Print > Properties. In the Document Properties window, select Paper Source, Paper
Type and Print Quality.
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5. Press the Margins/Layout button. In this example you can select Borderless because you have
already selected a photo paper (this option is only enabled with photo and glossy papers). The
default image enlargement method is Automatically by printer. The option Manually in
application can be used when you want to control the amount of enlargement precisely.
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6. Inthe Color tab, the default color management option is Printer Managed Colors, and this is the
correct option because you have already selected Let Printer Determine Colors in Photoshop.
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Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office.

Using PowerPoint

1. Select the Office Button, then Print, and select the name of your printer.
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2. Select Properties > Features > Print document on to scale the document to a particular size.
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4.  Select Margins/Layout, then select Clip contents by margins to keep the size.
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Using Project
1. Select File > Page Setup > Print.
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2. Select your printer's name, then Close.
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4.  Select Options to go to the printer driver. The default options in the Paper/Quality tab are probably
suitable: Paper source: Printer auto select and Paper Type: Any.
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5. Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Project.
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Using Excel
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1. Select the Office Button, then Print. Select your printer's name, then click Close.
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2. Select the Page Layout tab, then Size, and choose the paper size you want.
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3. Select the Office Button, then Print > Properties to go to the printer driver. In the Paper/Quality
tab, select Paper source, Paper Type and Print Quality.
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4.  Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Excel.
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Job queue management

° Introduction

e Job queue page (T1200 series only)

e Job preview (T1200 series only)

e Turn off the job queue (T770 HD and T1200 series only)

e Select when to print a job in the queue (T770 HD and T1200 series only)

° Identify a job in the queue (T770 HD and T1200 series only)

e  Prioritize a job in the queue (T770 HD and T1200 series only)

° Delete a job from the queue (T770 HD and T1200 series only)

e Reprint or copy a job in the queue (T770 HD and T1200 series only)

e Job status messages (T770 HD and T1200 series only)
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Introduction

The job queue management options described in this chapter are available for the following printers.
e T1200 series: all options in this chapter

e T770 HD: front panel options only

e T770and T770 PS: no job queue management

Job queue page (T1200 series only)

You can manage your printer's job queue from the HP Ultility, see Access the HP Utility on page 29, or
the printer's Embedded Web Server, see Access the Embedded Web Server on page 29.

By default, the access to the job queue is open to all users. An administrator can set a password so that
users are required to enter a password for:

e Seeing job previews
e Canceling or deleting jobs

The job queue page shows all jobs that are available in the printer job queue. It includes jobs that are
being received, parsed, rendered, printed and already printed.

The following information displayed for each job:

e Preview: Click the icon to see the job preview. The job preview is available once the job is
processed.

e File name: Click the file name to see the properties of the job.
e  Status: Gives the current job status.

e Pages: Number of pages in the job.

e Copies: Number of copies printed.

e Date: Date and time the printer received the job.

e User: The user's name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title
of the corresponding column. You can perform the following operations on one or all jobs in the queue:

e Cancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job
remains stored in the printer, but will not be printed unless you click Reprint.

e Hold: Holds the select jobs until you click Continue to print.
e Continue: All selected jobs, which are on hold, continue printing.

e Reprint: Prints more copies of a job. Type the number of copies (default 1, maximum 99) and
click Print.

e Move to front: Sends all selected jobs to the top of the job queue.

e Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is
deleted.
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e Refresh: Refreshes the page, ensuring the information is updated.

Bf NOTE: The job queue page does not automatically update.
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Job preview (T1200 series only)

The printer samples all incoming jobs and generates a JPEG file that can be served as a preview of the
job. This preview is available for all languages supported by the printer: the T1200 PS supports PDF,
PostScript, HPGL/2, RTL, TIFF and JPEG.

Bf NOTE: Do notsend a job for preview with more than 64 pages, this may cause the driver software to
crash.

Job preview is available once the job is processed. To access the preview page, click the magnifying
glass icon, which appears in the Preview column on the job queue page. The preview page shows the
following job details along with a thumbnail preview of the job:

e File name: The file name of the job.
e Loaded paper: The type of paper loaded in the printer.
e Job dimensions: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which
appears on the right hand side of the printer image.

Bf NOTE: Browsers without the Macromedia plug-in show the job image as yellow shaded. Browsers
that have the Macromedia flash plug-in version 7 and above shows an enhanced preview of the job
image inside the paper loaded in the printer.

Turn off the job queue (T770 HD and T1200 series only)

You can turn off the job queue in the following ways.

e Using the Embedded Web Server (T1200 series only): Select the Setup tab, then Printer
settings > Job management > Queue and select Off.

Using the front panel: Select the Setup menu icon , then Job management options > Enable
queue > Off.

Select when to print ajob in the queue (T770 HD and T1200
series only)

Bf NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue.

e Using the Embedded Web Server (T1200 series only): Select the Setup tab, then Printer
settings > Start printing.

®  Using the front panel: Select the Job management menu icon @] then Job queue.

Job queue
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There are three options you can select:

e When After Processing is selected, the printer waits until the whole page has been processed
and then it starts to print. This is the slowest setting but ensures the best print quality in large or
complex prints.

e When Immediately is selected, the printer prints the page as it is processed. This is the quickest
setting, but the printer may stop halfway through a print to process data. This setting is not
recommended for complex images with dense color.

e When Optimized is selected (this is the default setting), the printer calculates the best time to begin
printing the page. It is usually the best compromise between the After Processing and
Immediately settings.

Identify ajob in the queue (T770 HD and T1200 series only)

The best way to look at the queue is in the Embedded Web Server (Main tab > Job queue), where you
can manage the queue and get full information on every job (by clicking the name of the file). However,
this method is available for the T1200 series only.

You can also manage the queue from the front panel. To do so, select the Job management menu icon
@], then Job queue, where you can see a list of the jobs in the queue.

Each has an identifier, comprising:

<position in queue>: <image name>

The job currently being printed has a check mark, canceled jobs have crosses, processing jobs have a
clock and jobs on hold have a warning.

Prioritize ajob in the queue (T770 HD and T1200 series
only)

You can select any job in the queue and make it the next one to be printed.
e Using the Embedded Web Server (T1200 series only): After selecting the job, select Reprint.
e Using the front panel: After selecting the job, select Move to front.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be
printed next, and on its own on the roll, first turn nesting off and then move it to the front of the queue
as described above.

Delete a job from the queue (T770 HD and T1200 series
only)

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will
just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and
want to avoid printing it, you can simply delete it.

e Using the Embedded Web Server (T1200 series only): Select the job and then select Delete.
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e Using the front panel: Select the job and then select Delete.

In the same way, you can delete a job that has not been printed yet.
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If the job is currently being printed (its status is printing in the Web server), you may want to cancel it
and then delete it.

e Using the Embedded Web Server (T1200 series only): After selecting the job, select Cancel and
then Delete.

e Using the front panel: After selecting the job, press the Cancel key and then select Delete.

Reprint or copy ajob in the queue (T770 HD and T1200
series only)

To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server
(T1200 series only) and click the Reprint icon, then specify the number of copies you want. The job will
be moved to the top of the queue. To make more than one print of a non-printed job in the queue from
the front panel, select the job and choose Copies, then specify the number of copies required and press
the Select key. This overrides any value set by your software.

Bf NOTE: If Rotate was On when you sent the file, every copy will be rotated.

You can reprint an already-printed job from the front panel. Select the Job management menu icon
@, then select the job from the queue, then select Reprint.

Bf NOTE: You cannot use this method for PCL3 jobs. To reprint old jobs that are PCL3, you may be able
to use your operating system's printer spooler, if you have already set the spooler to save old jobs. This
facility depends on your operating system.

Job status messages (T770 HD and T1200 series only)
These are the possible job status messages, approximately in the order in which they may be seen:
e Receiving: the printer is receiving the job from the computer

e Waiting to process: the job has been received by the printer and is waiting to be rendered (for
jobs submitted through the Embedded Web Server only)

e Processing: the printer is parsing and rendering the job
e Preparing to print: the printer is performing writing system checks before printing the job
e Waiting to print: the job is waiting for the print engine to become free to proceed with printing

e Waiting for nest: the printer is set up with Nesting=On and is waiting for other jobs in order to
complete the nest and proceed with printing

e On hold: the job was sent with the on hold for preview option and is on hold

B NOTE: Do notsend ajob for preview with more than 64 pages, this may cause the driver software
to crash.

NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially
printed job will appear in the queue as on hold when the printer is next turned on. When you resume
the job, it will start printing at the page at which it was interrupted.

e On hold for paper: the job can't be printed because the right paper is not loaded in the printer.
Load the required paper, see Paper handling on page 33, and click Continue to resume the job

Job queue

e On hold for accounting: the job can't be printed because the printer requires all jobs to have an
account ID: enter the account ID and then click Continue to resume the job

¥ TIP: To setan account ID, see Require account ID (T1200 series only)on page 25.
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e Printing

e Drying

e  Cutting paper

e Ejecting page

e Canceling: the job is being canceled, but will remain in the printer job queue
e Deleting: the job is being deleted from the printer

e Printed

e Canceled: the job has been canceled by the printer

e Canceled by user

e Empty job: the job does not contain anything to print

Reactivate a job on hold (T1200 series only)

When the printer puts a job on hold you receive an alert, see Printer alerts on page 184, which explains
why the job is on hold. Follow the instructions on the screen to remove the hold and continue printing.
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11 Retrieving printer usage information

e Get printer accounting information

° Check printer usage statistics

e  Check ink and paper usage for a job
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Get printer accounting information

There are various different ways of getting accounting information from your printer.

e View printer usage statistics for the whole lifetime of the printer, see Check printer usage
statistics on page 114.

e View ink and paper usage for each of your recent jobs by using the HP Utility, see Check ink and
paper usage for a job on page 114. If the HP Ultility is not available, see Access the HP Utility
on page 29.

e Use a third-party application to request printer status, printer usage or job accounting data from
the printer through the Internet. The printer provides data in XML to the application whenever
requested. HP provides a Software Development Kit to facilitate the development of such
applications.

Check printer usage statistics

There are two ways to check your printer's usage statistics.

Bf NOTE: The accuracy of the usage statistics is not guaranteed.

Printer statistics with the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 29.

2. Under Windows, go to the Overview tab and click on the Printer usage link.

Under Mac OS, select Information > Printer Usage and click on the Lookup button.

Printer statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded \Web Server on page 29.

2. Go to the Main tab.

3. Select History > Usage.

Check ink and paper usage for a job

There are two ways to check ink and paper usage for a job.

Bf NOTE: The accuracy of the usage statistics is not guaranteed.

Ink and paper statistics with the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 29.

2. Select Job center to view information regarding the most recent jobs.
3. Under Windows, click on the Accounting link.

Under Mac OS, select Job Accounting and click on the Look Up button.

114 Chapter 11 Retrieving printer usage information ENWW



Ink and paper statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 29.

2. Go to the Main tab.

3. Select History > Accounting.
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ENWW

Handling ink cartridges and printheads

e About the ink cartridges

e Check the ink cartridges status

° Remove an ink cartridge

° Insert an ink cartridge

° About the printheads

e Check the printhead status

° Remove a printhead

° Insert a printhead
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About the ink cartridges

Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper.
To purchase additional cartridges, see Accessories on page 135.

/A CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive
devices (see the Glossary on page 209). Avoid touching pins, leads and circuitry.

Check the ink cartridges status

To view the ink levels of your ink cartridges, press the View ink level key on the front panel.

To get more information on your ink cartridges, you can use the front panel ink menu or the HP Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages
on page 172.

Ink menu procedure

1 From the front panel, select the Ink menu icon , then Ink cartridge information.

2. Select the cartridge on which you want information.

3. The front panel displays:

Color

Product name

Product number

Serial number

Status

Ink level, if known

Total ink capacity in milliliters
Expiration date

Warranty status

Manufacturer

HP Utility procedures

e Inthe HP Utility for Windows, go to the Overview tab, each cartridge's status is under Supplies
Status > Cartridges.

e Inthe HP Utility for Mac OS, select Printer Status in the Information group.

Remove an ink cartridge

There are two occasions when you need to remove an ink cartridge.

e The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing
(you can use up the remaining ink in the first cartridge at a more convenient time).

e Theink cartridge is empty or faulty, and you must replace it to continue printing.
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/A CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION: Remove an ink cartridge only if you are ready to insert another one.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

Bf NOTE: When a cartridge runs out of ink, the current job is not automatically cancelled: unless you
cancel it manually, it will resume printing when the empty cartridge has been replaced. If there is a delay
in replacing the cartridge, you may see some banding on the print.

L From the front panel, select the Ink menu icon , then Replace ink cartridges.

Ink

iew ink levels

- Feplace ink cartridges

» Replace printheads

B Ink cartridge information
Frinthead information
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2. Open the ink cartridge cover on the left-hand side of the printer.

3.  Grip the cartridge you wish to remove.
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4. Pull the cartridge straight up.

Bf NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be
ink on the connection.

NOTE: Avoid storing partially used ink cartridges.
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5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters
(in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the
cartridge label.

3. Insert the ink cartridge into its slot.
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4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see
confirmation that the cartridge has been inserted.

e

=

If you have difficulty, see Cannot insert an ink cartridge on page 172.

5. When all cartridges have been inserted, close the cover.
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6.  The front-panel display confirms that all cartridges have been correctly inserted, press the OK key
on the front panel.

About the printheads

The printheads are connected to the ink cartridges and jet ink onto the paper.

/A CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices
(see the Glossary on page 209). Avoid touching pins, leads and circuitry.

Check the printhead status

The printer automatically checks and services the printheads after each print. Follow the steps below
to get more information on your printheads.

1 From the front panel, select the Ink menu icon , then Printhead information.

2. Select the printhead on which you want information.
3. The front panel displays:

e Colors

e  Product name

' Product number
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e Serial number

° Status, see Front-panel error messages on page 185

e Volume of ink it has used
e Warranty status

You can also get most of this information without leaving your computer by using the HP Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 178.

If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the HP
Legal Information document provided with your printer for details of the warranty implications.

Remove a printhead

/A CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

=]
~
o
S
o
ge)
=
S
=
>
®
QD
Q
v

/A CAUTION: Printhead replacement must be performed with the printer powered on.

1 From the front panel, select the Ink menu icon , then Replace printheads.

Ink

e iew ink levels
» Replace ink cartridges

- Replace printheads
B Ink cartridge information
Printhead information

2. The printer moves the carriage into the correct position.

/A CAUTION: If the carriage is left in the removal position for more than three minutes without
inserting or removing any printheads, it tries to move back to its normal position in the right-hand
end.

3. When the carriage has stopped moving, the front-panel display asks you to open the window.

122 Chapter 12 Handling ink cartridges and printheads ENWW



4.  Locate the carriage on the right side of the printer.

5. Pull the handle up and toward you to release the wire loop.

6. Push the handle back to raise the lid.
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7. This gives you access to the printheads.
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8. Toremove a printhead, lift up the blue handle.

9. Using the blue handle, use steady force to disengage the printhead.

=]
~
o
S
o
©
=
S
=
>
®
QD
Q
v

10. Pull the blue handle upward until the printhead is released from the carriage.

/A CAUTION: Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.
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Insert a printhead

1.  Remove the orange protective caps by pulling them down.
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2. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check
that the colored label on the printhead matches the colored label of the carriage slot into which the
printhead is to be inserted.

3. Insert the new printhead into its correct slot in the carriage.

/A CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you
insert it too fast, or at an angle, or if you rotate it as you insert it.
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4. Push down as indicated by the arrow shown below.

/A CAUTION: When installing the new printhead there may be some resistance, so you need to
press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel
display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead

on page 172.

5. Insert all other printheads that need to be installed, and close the carriage lid.
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6. Ensure the end of the blue handle catches the wire loop on the near side of the carriage.
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7. Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer
beeps.

Ef NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front-panel display, the printhead may need to be reinserted.
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8. Close the window.

9. The front-panel display confirms that all printheads are correctly inserted. The printer starts
checking and preparing the printheads. The default routine process, when all printheads are
changed, takes 10 minutes. If the printer finds problems in preparing the printheads, it takes longer,
up to 45 minutes. For a single printhead insertion, the times vary between 2 and 40 minutes. After
all printheads are checked and prepared, the printhead realignment procedure runs automatically
if paper is loaded, see Align the printheads on page 176.

10. You are recommended to perform a color calibration after inserting a new printhead. See Color
calibration on page 70.
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Maintaining the printer

e  Check printer status

° Clean the exterior of the printer

° Maintain the ink cartridges

° Move or store the printer

° Update the firmware

° Update the software

° Printer maintenance Kkits

e Secure Disk Erase (T770 HD and T1200 series only)
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Check printer status

You can check the current status of the printer in various ways:

e Ifyou start the HP Utility and select your printer, you see a page of information describing the status
of the printer and its paper and ink supplies.

e If you access the Embedded Web Server, you see information about the general status of the
printer. The Supplies page in the Main tab describes the status of the paper and ink supplies.

e The status screen of the printer's front panel notifies you of any current problems affecting the
printer as a whole. You can also request information about:

o The currently loaded paper, with the View information key m or ()

o

The ink levels, with the View ink levels key |7 or |

The ink cartridges, by selecting the Ink menu icon and then Ink cartridge information

°  The printheads, by selecting the Ink menu icon and then Printhead information

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid
soap.

/A WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before
you clean it. Do not let water get inside the printer.

/A CAUTION: Do not use abrasive cleaners on the printer.
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Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer's front
panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 130.

See also Handling ink cartridges and printheads on page 117.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare
the printer, follow the instructions below.

1. Do not remove the ink cartridges or printheads.
2. Make sure that no paper is loaded.
3. Make sure that the printer is idle.

4. Disconnect any cables connecting the printer to a network or a computer.
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If you need to leave the printer turned off for a long time, follow the additional steps below.
1. Turn off the power using the Power key on the front panel.
2. Also turn off the power switch at the rear of the printer.

3. Disconnect the printer's power cable.

/A CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious
damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and
prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the
printer has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.

/A CAUTION: If the printer remains off for a long period of time, the printheads may become unusable.
In this case, you need to replace the printheads with new ones.

> TIP: Because preparing and purging the printheads uses both time and ink, you are strongly
recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the health
of the printheads. In both cases, the printer wakes up from time to time to maintain the printheads. Thus
you can avoid going through lengthy preparation processes before using your printer.

Update the firmware

The printer's various functions are controlled by software that resides in the printer, otherwise known
as firmware.

From time to time firmware updates will be available from Hewlett-Packard. These updates increase the
printer's functionality and enhance its features.

Firmware updates can be downloaded from the Internet and installed in your printer in the following
ways; you can choose whichever you find most convenient.
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e Using the HP Utility under Windows, select your printer, the Support tab and then Firmware
Update.

e Using the HP Utility under Mac OS, select Firmware Update in the Support group.
e Using your printer's Embedded Web Server, select the Main tab and then Firmware update.

In each case, follow the instructions on your screen to download the firmware file and store it on your
hard disk. Then select the downloaded file and click Update.

= NOTE: Firmware upgrades are digitally signed by HP. You are not recommended to use unsigned
firmware upgrades. If you attempt to do so, the front panel will ask you to confirm.

If you experience very slow progress while uploading the firmware file to the printer, the reason could
be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the
Embedded Web Server directly.

e InInternet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more
precise control, click the Advanced button and add the printer's IP address to the list of exceptions,
for which the proxy server is not used.

e In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

The firmware includes a set of the most commonly used paper presets. Extra paper presets can be
downloaded separately; see Paper presets on page 45.
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Update the software

To update printer drivers and other software for your printer, go to http://www.hp.com/go/T770/
drivers/ or http://www.hp.com/go/T1200/drivers/.

If your operating system is Windows, HP Software Update regularly offers to update your software
automatically.

Printer maintenance Kits

Four maintenance kits are available for your printer, containing components that may need to be
replaced after long use. When one of them is needed, a message is displayed on the front panel and
by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 190)
and request the maintenance kit. The kits are installed by service engineers only.

Secure Disk Erase (T770 HD and T1200 series only)

The printer's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility
can completely erase your information from the hard disk to protect it from unauthorized access. You
can choose to erase particular files, or the whole hard disk.

Secure Disk Erase provides three different levels of security:

e Non-Secure Fast Erase: all pointers to the information are erased. The information itself remains
on the hard disk until the disk space it occupies is needed for other purposes, and it is then
overwritten. While it remains on the disk, it is difficult for most people to access, but may be
accessed using software designed for the purpose. This is the normal method in which files are
erased on most computer systems; it is the fastest method but the least secure.

e Secure Fast Erase: all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but
more secure. It may still be possible to access fragments of the erased information by using special
tools to detect residual magnetic traces.

i)
=.
=
=
®
@
=
Q.
=
—+
(1)
S
Y
=
o
®

[}

I'mv amt

DoD

Secure Fast Erase
Del 5320.22-M

132 Chapter 13 Maintaining the printer ENWW


http://www.hp.com/go/T770/drivers/
http://www.hp.com/go/T770/drivers/
http://www.hp.com/go/T1200/drivers/

e Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of
Defense 5220-22.m requirements for clearing and sanitization of disk media. This is the default
security level when using Secure Disk Erase.
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Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based
print management software: see http://www.hp.com/go/webjetadmin/.

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support:
see Contact HP Support on page 190.

Bf NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several
times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure
Sanitizing Erase.
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14 Accessories

° How to order supplies and accessories

° Introduction to the accessories
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How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

° Visit http://www.hp.com/go/T770/accessories/ or http://www.hp.com/go/T 1200/accessories/ on the
Web.

e Contact HP Support (see Contact HP Support on page 190).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your printer.

Table 14-1 Ink cartridges

Cartridge Part number
HP 72 69 ml Photo Black Ink Cartridge C9397A
HP 72 69 ml Cyan Ink Cartridge C9398A
HP 72 69 ml Magenta Ink Cartridge C9399A
HP 72 69 ml Yellow Ink Cartridge C9400A
HP 72 69 ml Gray Ink Cartridge C9401A
HP 72 130 ml Matte Black Ink Cartridge C9403A
HP 72 130 ml Photo Black Ink Cartridge C9370A
HP 72 130 ml Cyan Ink Cartridge C9371A
HP 72 130 ml Magenta Ink Cartridge C9372A
HP 72 130 ml Yellow Ink Cartridge C9373A
HP 72 130 ml Gray Ink Cartridge C9374A
HP 726 300 ml Matte Black Ink Cartridge (T1200 series only) CH575A
>
X Table 14-2 Printheads
§ Printhead Part number
g_ HP 72 Gray & Photo Black Printhead C9380A
8 HP 72 Magenta & Cyan Printhead C9383A
HP 72 Matte Black & Yellow Printhead C9384A

Order paper

The following paper types are currently provided for use with your printer.

B NOTE: This listis likely to change over the course of time. For the latest information, see
http://www.hp.com/go/T770/accessories/ or http://www.hp.com/go/T1200/accessories/.

NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.
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Key to availability:

e (A)indicates papers available in Asia (excluding Japan)

e (C)indicates papers available in China

e (E) indicates papers available in Europe, the Middle East and Africa

e (J)indicates papers available in Japan

e (L) indicates papers available in Latin America

e (N)indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Table 14-3 Roll paper

Paper type g/m2 Length Width Part numbers
HP Bond and Coated Paper
HP Universal Inkjet Bond Paper 80 150 ft =45.7 m 23.39 in = 594 mm (A1) Q8003A (AJ)
24in =610 mm Q1396A
36in =914 mm Q1397A
42in =1067 mm Q1398A
300 ft=91.4m 23.39in =594 mm (A1) Q8004A (EAJ)
33.11in =841 mm (A0) Q8005A (EAJ)
HP Bright White Inkjet Bond Paper 90 150 ft =45.7 m 16.54 in = 420 mm (A2) Q1446A (J)
23.39 in = 594 mm (A1) Q1445A (EJ)
24in =610 mm C1860A (LN),
C6035A (AEJ)
33.11in =841 mm (A0) Q1444A (EJ)
36in =914 mm C1861A (LN),
C6036A (AEJ)
300 ft=91.4m 36in =914 mm C6810A g
HP Recycled Bond Paper 80 150 ft =45.7 m 16.54 in = 420 mm (A2) CGB889A (EN) §
24in =610 mm CG890A (EN) §
36in =914 mm CGB891A (EN) é(’
42 in =1067 mm CG892A (EN)
HP Cockle-free Coated Paper 100 150 ft=45.7m 24 in =610 mm CG883A (EN)
36in =914 mm CGB884A (EN)
42 in =1067 mm CG885A (EN)
HP Cockle-free Heavyweight 170 100 ft=30.5m 24 in =610 mm CG886A (EN)
Coated Paper
36in =914 mm CG887A (EN)
42in =1067 mm CG888A (EN)
HP Universal Coated Paper 95 150 ft =45.7 m 24 in =610 mm Q1404A (AEJN)
36in =914 mm Q1405A (AEJN)
42in =1067 mm Q1406A
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Table 14-3 Roll paper (continued)

Paper type g/m?2 Length Width Part numbers
HP Coated Paper 90 150 ft=45.7 m 16.54 in =420 mm (A2) Q1443A (J)
18 in = 458 mm Q7897A (EJN)
23.39in = 594 mm (A1) Q1442A (EJ)
24 in =610 mm C6019B
33.11in = 841 mm (A0) Q1441A (EJ)
36 in =914 mm C6020B
42in =1067 mm C6567B
300ft=91.4m 36 in =914 mm C6980A
HP Universal Heavyweight Coated 120 100 ft =30.5m 24 in =610 mm Q1412A (AEJN)
Paper
36 in =914 mm Q1413A
42in = 1067 mm Q1414A (AEJN)
HP Heavyweight Coated Paper 131 100 ft =30.5 m 24 in =610 mm C6029C (AEJN)
36in =914 mm C6030C
42 in = 1067 mm C6569C
225ft=67.5m 42in = 1067 mm Q1956A (EN)
HP Super Heavyweight Plus Matte 210 100 ft =30.5 m 24 in =610 mm Q6626A (AEJN)
Paper
36 in =914 mm Q6627A (AEJN)
42in = 1067 mm Q6628A (AEJN)
HP Colored Paper Fluorescent 100 150 ft=45.7 m 36in =914 mm Q1757A (E)
Yellow
HP Colored Paper Yellow 92 150 ft=45.7m 36 in =914 mm Q1760A (EN)
2953 ft=90 m 23.39in =594 mm (A1) Q6596A (E)
HP Technical Paper
HP Natural Tracing Paper 90 150 ft=45.7 m 16.54 in = 420 mm (A2) Q1440A (J)
23.39in =594 mm (A1) Q1439A (J)
24in =610 mm C3869A
33.11in = 841 mm (A0) Q1438A (J)
36 in =914 mm C3868A
HP Translucent Bond 67 150 ft=45.7m 24 in =610 mm C3860A (AJN)
36in =914 mm C3859A (LN)
HP Vellum 75 150 ft=45.7 m 24in =610 mm C3862A (N)
36in =914 mm C3861A (LN)
HP Film (Technical and Graphic)
HP Clear Film 174 75ft=229m 24in =610 mm C3876A (AEJN)
36 in =914 mm C3875A
HP Matte Film 160 125ft=38.1m 24in =610 mm 51642A (AEJN)
36 in =914 mm 51642B
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Table 14-3 Roll paper (continued)

Paper type g/m2 Length Width Part numbers
HP Polyester Film White Matte 167 50ft=152m 36 in =914 mm Q1736A (AEN)
HP Vivid White Glossy Polyester 230 66 ft=20.1m 24 in =610 mm CG827A (EJN)
Film

42 in =1067 mm CG828A (EJN)
HP Photographic Paper
HP Universal Instant-Dry Photo 190 100 ft = 30.5 m 24in =610 mm Q6574A
Gloss

36in =914 mm Q6575A

42 in =1067 mm Q6576A
HP Universal Instant-Dry Photo 190 100 ft = 30.5 m 24 in =610 mm QB6579A
Semi-Gloss

36in =914 mm Q6580A

42 in =1067 mm Q6581A

TIP: The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for
more than two weeks, you should laminate them to achieve longer life.

0
)
=
o
0
0
)
%)
3]
<

HP Premium Plus Photo Gloss 286 50ft=152m 24 in =610 mm Q5488A
HP Premium Plus Photo Satin 286 50ft=152m 18 in =458 mm Q7920A
24 in =610 mm Q5491A
HP Universal High-Gloss Photo 190 100 ft=30.5m 24 in=610 mm Q1426A (AEJN)
Paper
36 in =914 mm Q1427A (AEJN)
42 in = 1067 mm Q1428A (AEJN)
HP Universal Semi-Gloss Photo 190 100 ft = 30.5 m 24 in =610 mm Q1420A (AEJN)
Paper
36 in =914 mm Q1421A (AEJN)
42 in = 1067 mm Q1422A (AEJN)
HP Photo Paper RC Matte 200 100 ft=30.5m 36 in =914 mm C7946A (AEN)
HP Backlit Material
HP Backlit Film Reverse Print Matte 160 75ft=229m 36 in =914 mm C7960A (AEJN)
HP Self-Adhesive Material and Laminate
HP Two-View Cling 240 75ft=229m 36 in =914 mm Q1914A (AEN)
42 in = 1067 mm Q1915A (AEN)
HP Indoor Paper Self-Adhesive 170 75ft=229m 36 in =914 mm Q1733A (EJN)
HP Polypropylene, Matte — 225 70ft=21.3m 36 in =914 mm Q1908A (AEN)
Adhesive Backed
HP Self-Adhesive Satin/Gloss 75ft=229m 36 in =914 mm Q8834A
Polypropylene
42 in = 1067 mm Q8835A
HP Adhesive-backed Polypropylene 128 164 ft =50 m 36 in =914 mm Q8044A (C)
Table 14-4 Sheet paper
Paper type g/m2 Length Width Part numbers

HP Bond and Coated Paper
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Table 14-4 Sheet paper (continued)

>
3)
)
o)
0
0
o
=
)
n

Paper type g/m?2 Length Width Part numbers
HP Coated Paper 90 24in =610 mm 18 in =457 mm Q1961A (AEJN)
36 in = 914 mm 24in =610 mm Q1962A (AEN)
HP Photographic Paper
HP Premium Plus Photo Gloss 286 19in =483 mm 13in =330 mm Q5486A
24in =610 mm 18 in = 457 mm Q5487A
HP Premium Plus Photo Satin 286 19in = 483 mm 13 in =330 mm Q5489A
24in =610 mm 18 in = 457 mm Q5490A
Order accessories
The following accessories can be ordered for your printer.
Name Product number
HP Designjet T770 Memory Upgrade CN499A
HP Designjet T770 PostScript Upgrade CN500A
HP Designjet External Hard Disk CN501A
HP Designjet T770 & T1200 Spindle Q6709A
HP Designjet 3 inch Spindle Adaptor Kit CN538A
HP Jetdirect 630n IPv6 Gigabit Print Server J7997G
HP Jetdirect 635n IPv6/IPsec Print Server J7961A

Introduction to the accessories

Memory upgrade (T770 only)
The memory upgrade may be useful if you sometimes experience “Out of memory” errors when printing.
It can be plugged into the printer's USB host, providing 6 GB of extra memory.

PostScript upgrade (T770 series only)

The PostScript upgrade provides a PostScript interpreter, enabling you to send PostScript and PDF files
to the printer. It includes the 6 GB memory upgrade as above, so you do not need both. The PostScript
upgrade can be plugged into the printer's USB host.

Bf NOTE: The included 6 GB memory upgrade applies to the T770 only, and not to the T770 HD.

External hard disk (T1200 series only)

The external hard disk enables you to remove the hard disk for security reasons. It can be plugged into
the printer's USB host.

Spindle

With extra spindles, you can change rapidly from one paper type to another.
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Jetdirect print server

Jetdirect print servers support extra connectivity and security options beyond those provided in the
standard Gigabit Ethernet interface built into the printer.

For more information on IPsec configuration, download the file IPsec_ Admin_Guide.pdf from
http://www.hp.com/go/T1200/manuals/ or http://www.hp.com/go/T770/manuals/.

Accessories
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15 Troubleshooting paper issues

e The paper cannot be loaded successfully

° The paper type is not in the driver

e The printer printed on the wrong paper type

e An “on hold for paper” message (T1200 series only)

e The roll paper will not advance

e The paper has jammed

° A strip stays on the output tray and generates jams

e The printer displays out of paper when paper is available

° Prints do not fall neatly into the basket

e The sheet stays in the printer when the print has been completed

e The paper is cut when the print has been completed

e The cutter does not cut well

e Therollis loose on the spindle

° Recalibrate the paper advance

Paper issues
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The paper cannot be loaded successfully

Ensure no paper is loaded.
Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.

Do not attempt to straighten the paper during the aligning process, unless instructed to do so by
the front-panel display. The printer automatically attempts to straighten the paper.

The paper may be crumpled, or warped, or may have irregular edges.

General unsuccessful roll load issues

If the paper does not load, the leading edge of the paper may not be straight or clean and needs
to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary
even with a new roll of paper.

Ensure the roll ends are tight against the spindle ends.

Check that the spindle is correctly inserted.

Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
Check that all roll end plugs have been removed.

Check that the paper is wound tightly on the roll.

Do not touch the roll or paper at during the alignment process.

When loading a roll on the T1200 series, the roll cover must remain open until the front panel
prompts you to close it.

When loading the upper roll (the only roll on the T770), avoid inserting the paper into the cut sheet
slot.

Unsuccessful roll load

If the paper has not been inserted straight, the front panel displays the following instructions.

1.

When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to
straighten the roll.

When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the roll is aligned, the T1200 printer series prompts you to close the roll cover, and you are now
ready to print.

If the roll is still not aligned, the front panel displays an error and instructions to start again.
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If you would like to start the load process again, cancel the process on the front panel and rewind
the roll from the end of the spindle until the edge is removed from the printer.

B NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load
e Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
e Ensure that the sheet is aligned with the reference line on the roll cover.

e Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-
panel display.

e Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.
In case of any problem, please follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects
the sheet from the front of the printer.

Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

Front-panel message Suggested action

Close the roll cover when the paper load Close the roll cover when the paper load is finished.

is finished

Lever lifted During the load process the blue lever was lifted. This prevents the printer from
loading the paper. Follow the instructions on the front-panel display.

Paper incorrectly loaded The paper has not been loaded correctly. Lift the blue lever, remove the paper and
lower the lever.

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much
skew. Follow the instructions on the front-panel display.

Paper loose around core The end of the roll has become loose around the core. Tighten the paper to the core
or insert a new roll.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the paper
is inserted fully and is not transparent.

Paper too big During the load process the printer has detected that the paper is either too wide or
too long (sheet only) to be loaded correctly. Press the Cancel key to stop the load
process. See Functional specifications on page 192.

Paper too small During the load process the printer detected that the paper is too narrow or too short
to be loaded in the printer. Press the Cancel key to stop the load process. See
Functional specifications on page 192.

Roll cover closed during paper load Do not close the roll cover until you are prompted to do so by the front panel.

process

Upper roll load and paper is inserted Avoid inserting roll paper into the cut sheet slot.

through the single sheet path

The paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver,
however, you must identify whether your paper is transparent or translucent, glossy or matte.
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Bf NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print
well on glossy paper.

Transparent or translucent paper

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/
Clear film.

If your paper is a translucent paper (for example, technical paper), select paper type Technical
paper > Natural Tracing Paper, Vellum or Translucent bond.

Glossy paper

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select
paper type Photo Gloss Paper. For Semi-gloss, Satin, Pearl or Luster finishes, select paper type Semi-
gloss/Satin Paper.

To increase gamut on photo paper, select paper type HP Universal High-Gloss Photo Paper or HP
Universal Semi-Gloss Photo Paper, depending on the finish.

Matte Paper

Your paper type selection for matte paper depends on the paper’s ink absorption capacity. To select a
paper category and type, first identify if your paper is general purpose or photographic. Then select the
recommended paper types.

General-purpose paper

e Fornatural tracing papers, select paper type Natural Tracing Paper <65 g/m2 or Natural Tracing
Paper > 65 g/m2, depending on the weight of the paper.

e Forthin papers (< 90 g/m?) uncoated papers (for example plain paper or bright white paper) select
paper type Bond and Coated Paper > Plain Paper.

e For light coated papers (< 110 g/m?), select paper type Bond and Coated Paper > HP Coated
Paper.

e For heavyweight coated papers (< 200 g/m?), select paper type Bond and Coated Paper >
Heavyweight Coated Paper.

e  For cockle-free very thick coated papers (> 200 g/m?), select paper type Bond and Coated
Paper > Super Heavyweight Coated Paper.

Photographic paper
For photographic paper, select paper type Photo Paper > Photo Matte Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select
paper type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper
categories from thinnest to thickest are:

e Plain Paper

e Coated Paper
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e Heavyweight Coated Paper
e  Super Heavyweight Coated Paper

For other image quality problems, see Troubleshooting print-quality issues on page 155.

The printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Any selected
for the Paper Type in the printer driver. When Any is selected the printer will print immediately on
whichever paper is loaded. Load your desired paper, see Paper handling on page 33, and select your
paper type specifically in the driver.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select your paper type from the
Paper Type list.

e Inthe Mac OS Printdialog (T770, T1200): select the Paper/Quality panel, then select your paper
type from the Paper Type list.

e Inthe Mac OS X 10.5 PostScript Print dialog (PostScript printers): select the Paper/Quality
panel, then select your paper type from the Paper Type list.

e Inthe Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Image Quality
panel, then select your paper type from the Paper Type list.

Bf NOTE: Any is the driver default.

An “on hold for paper” message (T1200 series only)

Based on a set of conditions that you can set when sending a job (see Paper mismatch action

on page 22), the printer will decide which of the loaded rolls of paper is more suitable to print the job. If
there is no roll of paper available that meets all the conditions, the printer will put the job on hold for
paper. You can manually resume the job, forcing it to print on a paper other than the one originally
specified, otherwise it will stay on hold.

Which criteria are used to decide on which roll ajob will be printed?

When a user sends a job, the desired paper type can be set (in the driver or in the Embedded Web
Server). The printer will print the job on a roll of paper of the chosen paper type that is large enough to
print the drawing without clipping. If there is more than one roll on which the job could be printed meeting
all the criteria, the roll will be chosen according to your preferences. These can be set from the printer’s
front panel: see Roll switching options on page 22.

When is a job put on hold for paper?

If the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 22), a job
is put on hold for paper in the following cases:

e The paper type that has been selected by the user is not currently loaded on the specified roll—or
on either of the rolls, if no roll has been specified.

e The paper type that has been selected by the user is loaded on the specified roll, but the drawing
is too large to fit on the roll—or on either of the rolls, if no roll has been specified.
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If | load a new roll of paper, will jobs that were on hold for paper be
automatically printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper
that could be printed on the loaded roll.
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| don’t like jobs being put on hold for paper. Can | prevent it?

Yes, this can be done from the front panel: see Paper mismatich action on page 22.

| set the option “Paper mismatch action” to Print anyway, but some jobs are
still put on hold

If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are put
on hold until you have checked the preview and resumed the job. Check that the Show print preview
option is not checked in the driver, and that there are no pending preview windows waiting for
confirmation to continue printing.

My job is exactly as wide as the roll of paper that is loaded on the printer,
but is put on hold for paper

Margins are managed in different ways depending on the file type:

e For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 36-inch
HP-GL/2 and HP RTL file can be printed on a 36-inch roll of paper and will not be put on hold for
paper.

e  For other file formats, such as PostScript, PDF, TIFF or JPEG, the printer assumes that margins
need to be added outside the drawing (as, in many cases, these formats are used for photographs
and other images that do not include margins). This means that, to print a 36-inch TIFF, the printer
needs to add margins, and the drawing needs 36.4 inches of paper to be printed; this would cause
the job to be put on hold if the paper that is loaded on the printer is only 36 inches wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip
contents by margins option can be used. This option will force the margins to be set inside of the
drawing, so a 36-inch TIFF can be printed on a 36-inch roll of paper without being put on hold.
However, if there is no white space already included in the drawing’s borders, some contents could
be clipped because of the margins.

The roll paper will not advance

If you have pushed the printer up against a wall, the roll may be touching the wall at the rear of the
printer. Use the wall spacers to ensure a minimum distance between printer and wall. See The wall
spacers on page 7.

The paper has jammed
When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

1. Power off the printer at the front panel and also switch it off at the rear.
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2. Open the window.

5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

Paper issues
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/A CAUTION: Do not move the paper sideways, as it could damage the printer.

6. Rewind the roll. If the paper is stuck and cannot be rewound further, cut it from the roll.

8. Lower the blue lever.
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9. Close the window.

11. Reload the roll, or load a new sheet see Paper handling on page 33.

Bf NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the
procedure and carefully remove all pieces of paper.

A strip stays on the output tray and generates jams

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-
bleed print or after the Form feed and cut key @ has been pressed, the cut strip remains in the output

tray. Only when the printer is not working, reach in the tray and remove the strip.

Paper issues
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The printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper.
If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

e Ensure the basket is correctly installed.
e  Ensure the basket is open.
e Ensure the basket not full.

e  Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll,
or remove prints manually as they are completed.

The sheet stays in the printer when the print has been
completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time

on page 46. If the paper is only partially ejected after the drying time, gently pull the sheet out of the
printer. If the automatic cutter is disabled, use the Form feed and cut key ‘@ on the front panel, see

Feed and cut the paper on page 47.

The paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying
time on page 46. You can disable the cutter, see Turn the automatic cutter on and off on page 46.

The cutter does not cut well

By default the printer is set to automatically cut the paper after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any
obstacles.

The roll is loose on the spindle

The roll may need to be replaced or reloaded. If your roll has a three-inch cardboard core, ensure the
core adaptors have been installed, see Load a roll onto the spindle on page 35.

Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper
placement of dots on the paper. If the paper is not advanced the proper distance between printhead
passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing.
However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate
the rate at which the paper advances. See Troubleshooting print-quality issues on page 155 for steps
to determine if paper advance calibration will solve your issue.
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You can check the paper advance calibration status of the currently loaded paper at any time by pressing
the View information key m on the front panel. The status may be one of the following.

EE)

DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers
in the Front Panel have been optimized by default and unless you experience image quality
problems in your printed image such as banding or graininess it is not recommended to recalibrate
the paper advance.

OK: This status indicates that the loaded paper has been calibrated before. However you may need
to repeat the calibration if you experience image quality problems such as banding or graininess
in your printed image.

NOTE: Whenever you update the printer's firmware, the paper advance calibration values are
reset to factory default, see Update the firmwareon page 131.

/A CAUTION: Transparent papers and films must be calibrated using Image Quality Maintenance menu
icon , then Paper advance calibration > Adjust paper advance, from step four in Recalibrating

the paper advance procedure.

Recalibrating the paper advance procedure

ENWW

1.

From the front panel, select the Image Quality Maintenance menu icon , then Paper advance

calibration > Calibrate paper advance. The printer automatically recalibrates the paper advance
and prints a paper advance calibration image.

Wait until the front panel displays the status screen and re-print your print.

NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the
paper advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration,
return to the default calibration, see Return to default calibration on page 154.

If you would like to fine-tune the calibration or are using a transparent paper, select the Image
Quality Maintenance menu icon , then Paper advance calibration > Adjust paper

advance.

Recalibrate the paper advance 153
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4.  Select the percentage of change from —100% to +100%. To correct light banding, decrease the
percentage.

To correct dark banding, increase the percentage.

5. Press the OK key on the front panel, to save the value.

6.  Wait until the front panel displays the status screen and re-print your print.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to
zero. To return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, select the Image Quality Maintenance menu icon , then Paper advance

calibration > Reset paper advance.

2. Wait until the front panel displays the operation has completed successfully.
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16 Troubleshooting print-quality issues
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e General advice

° Print quality troubleshooting wizard

° Horizontal lines across the image (banding)

° Lines are too thick, too thin or missing

e Lines appear stepped or jagged

° Lines print double or in the wrong colors

° Lines are discontinuous

° Lines are blurred

° Line lengths are inaccurate

° The whole image is blurry or grainy

e The paper is not flat

e The print is scuffed or scratched

° Ink marks on the paper

° Black ink comes off when you touch the print

e Edges of objects are stepped or not sharp

° Edges of objects are darker than expected

° Horizontal lines at the end of a cut sheet print

e Vertical lines of different colors

e White spots on the print

e Colors are inaccurate

e Colors are fading

e Theimage is incomplete (clipped at the bottom)

e Theimage is clipped

e Some objects are missing from the printed image

e A PDF file is clipped or objects are missing

° The Image Diagnostics Print

° If you still have a problem
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General advice

When you have any print-quality problem:

e To achieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper

on page 136.
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e Make sure that the paper type selected in the front panel is the same as the paper type loaded into
the printer. To check this, use the View information key m on the front panel. At the same time,

check that the paper type has been calibrated. Also make sure that the paper type selected in your
software is the same as the paper type loaded into the printer.

/A CAUTION: If you have the wrong paper type selected, you could experience poor print quality
and incorrect colors, and perhaps even damage to the printheads.

e Check that you are using the most appropriate print-quality settings for your purposes (see
Printing on page 53). You are likely to see lower print quality if you have moved the print-quality
slider to the 'Speed' end of the scale, or set the custom quality level to Fast.

e  Check that your environmental conditions (temperature, humidity) are in the recommended range.
See Environmental specifications on page 194.

e Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain
the ink cartridges on page 130.

Print quality troubleshooting wizard

The Print Quality Troubleshooting Wizard can help with the following problems:
e Horizontal lines across the image (banding)

e The whole image is blurry or grainy

° Lines are too thick, too thin or missing

e Colors are inaccurate

To start the wizard:

e From the HP Utility for Windows: go to the Support tab, and select Print quality
troubleshooting.

e From the HP Utility for Mac OS: select Print quality troubleshooting in the Support group.

e From the Mac OS Print dialog: go to the Services panel, select Device Maintenance, then
select Print quality troubleshooting from the list of maintenance tasks.

e From the Embedded Web Server: go to the Support tab, select Troubleshooting, then select
Print quality troubleshooting.
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Alternatively, or if you have other print quality problems, you can continue reading this chapter.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key m

2. Check that you are using appropriate print-quality settings for your purposes (see Printing
on page 53). In some cases, you can overcome a print-quality problem merely by selecting a higher
print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to
Quality. If you change the print-quality settings, you may wish to reprint your job at this point in
case the problem has been solved.

3. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 168.

4. If the printheads are working correctly, go to the front panel and press the View information key
m to see the paper advance calibration status. If the status is DEFAULT, try performing paper

advance calibration: see Recalibrate the paper advance on page 152.

If the problem persists despite all the above actions, contact your customer service representative for
further support.
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Lines are too thick, too thin or missing
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key D

2. Check that you are using appropriate print-quality settings for your purposes (see Printing
on page 53). Select the custom print-quality options in the driver dialog, and try turning on the
Maximum detail option (if available). You may wish to reprint your job at this point in case the
problem has been solved.

3.  If the resolution of your image is greater than the printing resolution, you may notice a loss of line
quality. If you are using the PCL or the HP-GL/2 and HP RTL driver for Windows, you can find
the Max. Application Resolution option in the driver dialog's Advanced tab, under Document
Options > Printer Features. If you change this option, you may wish to reprint your job at this
point in case the problem has been solved.

4. Iflines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics
Print on page 168.

5 fthe problem remains, go to the front panel and select the Ink menu icon , then Printhead

information to see the printhead alignment status. If the status is PENDING, you should align the
printheads. See Align the printheads on page 176. After alignment, you may wish to reprint your
job in case the problem has been solved.

6.  Go to the front panel and press the View information key m to see the paper advance calibration

status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate
the paper advance on page 152.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:
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1.  The problem may be inherent in the image. Try to improve the image with the application you are
using to edit it.
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2. Check that you are using appropriate print-quality settings. See Printing on page 53.

3.  Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option
(if available).

Lines print double or in the wrong colors

This problem can have various visible symptoms:

e Colored lines are printed double, in different colors.

AN\
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e The borders of colored blocks are wrongly colored.
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To correct this kind of problem:

1. Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 122 and Insert a printhead on page 125.

2. Align the printheads. See Align the printheads on page 176.

T
=
>
T

o)
c
Qo
=

<
i
7))
c
D
7]

Lines are discontinuous

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 53.

2. Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 122 and Insert a printhead on page 125.

3. Align the printheads. See Align the printheads on page 176.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 194.

2. Check that the paper type selected in the front panel is the same as the paper type you are using.
To check on the front panel, use the View information key m

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super
Heavyweight Plus Matte Paper.

4.  Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.
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5.

6.

If you are using glossy paper, try changing to a different type of glossy paper.

Align the printheads. See Align the printheads on page 176.

Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your
purposes, you can try to improve line length accuracy in the following ways.

1.

Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 192.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is
thinner or thicker than HP Matte Film will reduce line length accuracy.

Set the Print Quality slider to Quality.
Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
Load the roll of film and let it rest for five minutes before printing.

If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper
advance on page 152.

The whole image is blurry or grainy

ENWW

Check that the paper type you have loaded corresponds to the paper type selected in the front

panel and in your software. To check on the front panel, use the View information key m

Check that you are printing on the correct side of the paper.

Check that you are using appropriate print-quality settings (see Printing on page 53). In some
cases, you can overcome a print-quality problem merely by selecting a higher print-quality level.
For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change
the print-quality settings, you may wish to reprint your job at this point in case the problem has been
solved.

Go to the front panel and select the Ink menu icon , then Printhead information to see the
printhead alignment status. If the status is PENDING, you should align the printheads. See Align
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the printheads on page 176. After alignment, you may wish to reprint your job in case the problem
has been solved.

5. Go to the front panel and press the View information key m to see the paper advance calibration

status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate
the paper advance on page 152.

If the problem persists despite all the above actions, contact your customer service representative for
further support.
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The paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely
to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper
that becomes saturated with ink.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key D

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super
Heavyweight Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

The print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object.
This is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after
printing, depending on the amount of ink used and the environmental conditions at the time of printing.
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To reduce the risk of scuffs and scratches:

Handle prints carefully.
Avoid stacking prints on top of each other.

Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively,
leave a sheet of paper in the basket so that freshly printed sheets do not make direct contact with
the basket.
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Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the
printheads move over the paper, the printheads may come into contact with the paper and smear the
printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Press the Cancel key and also
cancel the job from your computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key m

Use a recommended paper type (see Order paper on page 136) and the correct print settings.

If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may
affect performance.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super
Heavyweight Plus Matte Paper.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

Try to increase the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper

This can happen after a lot of borderless printing, especially with non-standard paper sizes. Ink residues
on the platen are likely to mark the back of the paper.
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Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use
matte black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you
can select Photo Glossy Paper as the paper type (in the Photo Paper category).
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Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set
the print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try
setting the quality level to Normal. See Printing on page 53.

Edges of objects are darker than expected

i

i

If edges of objects seem darker than expected, and you have already set the print-quality slider to
Quality in the driver dialog, select the custom print-quality options, and try setting the quality level to
Normal. See Printing on page 53.

Horizontal lines at the end of a cut sheet print

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the
paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1.  Print the Image Diagnostics Print. See The Image Diagnostics Print on page 168.

2. Consider printing with roll paper.

3. Consider using larger margins around your image.

164 Chapter 16 Troubleshooting print-quality issues ENWW



Vertical lines of different colors

If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight
Coated Paper and HP Super Heavyweight Paper. See Order paper on page 136.

2. Try using higher print-quality settings (see Printing on page 53). For instance, if you have set the
Print Quality slider to Speed, try setting it to Quality.
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White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating
material. To avoid this problem:

1.  Trycleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View information key m At the
same time, check the color calibration status. If the status is PENDING or OBSOLETE, you should
perform color calibration: see Color calibration on page 70. If you have made any changes, you
may wish to reprint your job in case the problem has been solved.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 53). If you have
selected the Speed or Fast options, you may not get the most accurate colors. If you change the
print-quality settings, you may wish to reprint your job at this point in case the problem has been
solved.

4. If you are using Application Color Management, check that the color profile you are using
corresponds to the selected paper type and print-quality settings. If you have doubts about which
color settings to use, see Color management on page 69.

5. If the problem consists of color differences between your print and your monitor, please follow the
instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you
may wish to reprint your job in case the problem has been solved.
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6. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 168.

7.  Try using the color adjustment options to produce the colors you want. See Color adjustment
options on page 73.

If the problem persists despite all the above actions, contact your customer service representative for
further support.
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Color accuracy using EPS or PDF images in page layout applications

Page layout applications such as Adobe InDesign and QuarkXPress do not support color management
of EPS, PDF or grayscale files.

If you have to use such files, try to ensure that the EPS, PDF or grayscale images are already in the
same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if
your final goal is to print the job in a press that follows the SWOP standard, convert the image into SWOP
when you create it.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for
more than two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life
of prints (depending on the type of lamination) with all paper types. For more information, consult your
laminate provider.

The image is incomplete (clipped at the bottom)

e Did you press Cancel before all the data were received by the printer? If so, you have ended the
data transmission and will have to print the page again.

e The I/O timeout setting may be too short. This setting determines how long the printer waits for
the computer to send more data, before deciding that the job is finished. From the front panel,
increase the I/O timeout setting to a longer period and then send the print again. From the

Connectivity menu .I select Advanced > Select I/O timeout.

e There may be a communications problem between your computer and the printer. Check your USB
or network cable.

e Check to make sure that your software settings are correct for your current page size (for example,
long-axis prints).

If you are using network software, make sure it has not timed out.

The image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and
the printable area as understood by your software. You can often identify this kind of problem before
printing by previewing your print (see Preview a print on page 60).

e  Check the actual printable area for the paper size you have loaded.
printable area = paper size — margins

e Check what your software understands to be the printable area (which it may call "printing area"
or "imageable area"). For example, some software applications assume standard printable areas
that are larger than those used in this printer.
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e If you have defined a custom page size with very narrow margins, the printer may impose its own
minimal margins, clipping your image slightly. You may want to consider using a larger paper size,
or borderless printing (see Select margins options on page 56).

e If your image contains its own margins, you may be able to print it successfully by using the Clip
Contents by Margins option (see Select margins options on page 56).

e If you are trying to print a very long image on a roll, check that your software is capable of printing
an image of that size.
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e You may have asked to rotate the page from portrait to landscape on a paper size that is not wide
enough.

e If necessary, reduce the size of the image or document in your software application, so it fits
between the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe
Photoshop, Adobe lllustrator and CorelDRAW, use an internal 16-bit coordinate system which means
that they cannot handle an image of more than 32,768 pixels.

Bf NOTE: Animage 32,768 pixels long would print at a length of 54.61 in or 1.39 m if you select Best or
Quality in the driver, 109.23 in or 2.78 m if you select Fast, Normal or Speed in the driver.

If you try to print an image larger than this from these applications, the bottom of the image may be
clipped. To print the whole image, try these suggestions:

e  Try using the PostScript printer driver to print your job, if you have not already tried it.

e The Windows HP-GL/2 and HP RTL driver dialog includes an option called Max. application
resolution, which enables you to print successfully in this situation. You will not normally need to
change the default setting, which is Auto. However, you can find the option in the Advanced tab,
under Document Options > Printer Features.

e  Save the file in another format, such as TIFF or EPS, and open it with another application.

e Use a RIP to print the file.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some
specific workflows there may be issues that can lead to some objects missing from the output. Here are
some suggestions to help you to avoid this problem.

e  Try using the PostScript printer driver to print your job, if you have not already tried it.

e Selectasmaller page size and scale to the desired final page size in the driver or in the front panel.
e Save the file in another format, such as TIFF or EPS, and open it with another application.

e Use aRIP to print the file.

e Reduce the resolution of bitmap images in your application software.

e Select a lower print quality in order to reduce the resolution of the printed image.

A PDF file is clipped or objects are missing

In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some
objects when printing with the HP-GL/2 and HP RTL driver at high resolution. In order to avoid such
problems, upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version
7 onwards, these problems should be solved.
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The Image Diagnostics Print

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It
helps you to check the performance of the printheads that are currently installed in your printer, and
whether any printhead suffers from clogging or other problems.

To print the Image Diagnostics Print:
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1. Use the same paper type that you were using when you detected a problem.

2. Use the View information key D on the front panel to check that the selected paper type is the
same as the paper type loaded into the printer.

3. Atthe printer's front panel, select the Image Quality Maintenance menu icon , then Print
diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

e Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the
print quality that you will get from each color.

e Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part
complements the first, and aims more specifically to detect how many faulty nozzles each printhead
has.

Please look carefully at the print. The names of the colors are shown above the rectangles and in the
center of the patterns of dashes.

C-M Y- MK PK-G

M- 0

First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without
any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most
of the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing
dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.
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Here is an example of a gray printhead in a good state:

G

And here is an example of the same printhead in a bad state:

G

Corrective action

1.

ENWW

Clean any faulty printheads (see Clean the printheads on page 173). Then reprint the Image
Diagnostics Print to see whether the problem has been solved.

If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see
whether the problem has been solved.

If the problem remains, consider cleaning your printheads manually (see Clean the printheads
on page 173). You could also try reprinting your current print job, in case it now prints satisfactorily.

If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you
when this is necessary, but it may be worth trying even if the printer has not suggested it. See
Clean the printhead drop detector on page 173.

If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges
and printheads on page 117), or contact HP Support (see Contact HP Support on page 190).

The Image Diagnostics Print 169
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If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some
further things that you can do:

e  Try using a higher print-quality option. See Printing on page 53.

e  Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about
the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can
be downloaded from http://www.hp.com/go/T770/drivers/ or http://www.hp.com/go/T 1200/
drivers/.
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e Ifyou are using a non-HP RIP, its settings may be incorrect. See the documentation that came with
the RIP.

e  Check that your printer's firmware is up to date. See Update the firmware on page 131.

e Check that you have the right settings in your software application.
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Troubleshooting ink cartridge and
printhead issues

e Cannot insert an ink cartridge

° Ink cartridge status messages

e Cannot insert a printhead

e The front-panel display recommends reseating or replacing a printhead

e Clean the printheads

e Clean the printhead drop detector

e Align the printheads

° Printhead status messages
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Cannot insert an ink cartridge
1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label
right-side up and readable.

/A CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:
e  OK: the cartridge is working normally, with no known problems.
e Missing: there is no cartridge present, or it is not correctly connected to the printer.

° Low: the ink level is low.
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e Very low: the ink level is very low.

e Empty: the cartridge is empty.

e Reseat: you are recommended to remove the cartridge and then reinsert it.

e Replace: you are recommended to replace the cartridge with a new cartridge.
e Altered: there is something unexpected about the cartridge's status.

e Expired: itis past the cartridge's expiration date.

Cannot insert a printhead

1. Check that you have the correct type of printhead (model number).

2. Check that you have removed the two orange protective caps from the printhead.

3. Check that the colored label on the printhead is the same color as the label on the slot.
4. Check that the printhead is correctly oriented (compare with the others).

5. Check that you have correctly closed and latched the printhead cover, see Insert a printhead
on page 125.

The front-panel display recommends reseating or
replacing a printhead

1. From the front panel, turn the power off then on.

2. Check the front-panel display message, if it shows the ready message, the printer is ready to print.
If the problem remains continue with the next step.

3.  Remove the printhead, see Remove a printhead on page 122.
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4.  Clean the electrical connections on the backside of the printhead with a lint free cloth. You can
carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

/A CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles
on the bottom side of the printhead, especially not with any alcohol.

5. Reinsert the printhead, see Insert a printhead on page 125.

6. Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printheads

As long as the printer is kept turned on, an automatic cleaning is performed periodically. This ensures
there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have
not already done so, please see The Image Diagnostics Print on page 168 before proceeding.

To clean the printheads, go to the front panel and select the Image Quality Maintenance menu icon
, then Clean printheads. If you have gone through the Image Quality Diagnostic print process, you

know which colors are failing. Select the pair of printheads which contain the failing colors. If you are
not sure which colors to clean, you can also select to clean all printheads. Cleaning all printheads takes
about nine minutes. Cleaning a single pair of printheads takes about six minutes.

Bf NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

Clean the printhead drop detector

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in
order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block
the sensor print-quality is affected.

When the front panel displays a warning message that the clean process is needed, you are
recommended to clean the printhead drop detector. If you do not clean the printhead drop detector
immediately, the printer continues working normally, however, the front panel display continues to show
the warning.

/A CAUTION: Wear gloves to avoid getting ink on your hands.
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1. Turn off the printer at the front panel.

2. To avoid an electric shock, switch the printer off and unplug it.
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4. Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.

6.  With a dry lint free cloth, wipe the surface of the drop detector to remove any non-visible debris.
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7. Close the window.
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8.  Plug in and switch on the printer.

9. Power the printer on at the front panel.
(\Q)\

Align the printheads

Precise alignment between printheads is essential for accurate colors, smooth color transitions and
sharp edges in graphical elements. Your printer has an automatic printhead alignment process which
runs whenever a printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see Color
management on page 69; you may need to align the printheads.

Ef NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the
realignment procedure with the Image Quality Maintenance menu .

/A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure

1. If the realignment process is running and the wrong paper is loaded, press the Cancel key on the
front panel.

/A CAUTION: Do not print if the realignment process has been canceled. You can restart the
alignment with the Image Quality Maintenance menu procedure.

2. Load the paper you wish to use, see Paper handling on page 33. You can use a roll or cut sheet,
however, it must be A3 landscape or larger.

/A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

3.  Remove and re-insert all the printheads, see Remove a printhead on page 122 and Insert a
printhead on page 125. This starts the printhead alignment procedure.
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4. Ensure the window is closed, as a strong light source near the printer during printhead realignment
can affect alignment.

5.  The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.

Bf NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel
display shows any errors in the process.
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Image Quality Maintenance menu procedure

1. Load the paper you wish to use, see Paper handling on page 33. You can use a roll or cut sheet,
however, it must be A3 landscape or larger (420 by 297 mm).

/A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, select the Image Quality Maintenance menu icon , then Align
printheads. The printer checks to see if it has enough paper to run the realignment.
3. Ifthe loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

Ensure the window is closed, as a strong light source near the printer during printhead realignment
can affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process
complete before using the printer.
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Scanning errors during alignment

If the alignment process fails, a Scanning problems message appears on the front panel. This means
that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment
should be repeated before printing with good image quality. The problem may be due to:

e The paper used was not valid, repeat the alignment with valid paper

e Printhead health problems, clean printheads, see Clean the printheads on page 173

e The alignment was done with the window open, repeat the alignment with the window closed

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed,
there may be a failure in the scanning system needing reparation or the printheads, although clean, may
not work and need to be replaced.

Printhead status messages

These are the possible printhead status messages:
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e OK: the printhead is working normally, with no known problems

e Missing: there is no printhead present, or it is not correctly installed in the printer.

e Test printhead separately: you are recommended to test the printheads individually to find the
failing printhead. Remove all the printheads and insert them alone one by one, closing the latch
and the carriage cover after every insertion. The front-panel display indicates the failing one
showing the reseat or replace message.

e Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the
electrical connections, see The front-panel display recommends reseating or replacing a
printhead on page 172. If that fails, replace the printhead with a new printhead, see Remove a
printhead on page 122 and Insert a printhead on page 125.

e Replace: the printhead is failing. Replace the printhead with a working printhead, see Remove a
printhead on page 122 and Insert a printhead on page 125.

e Replacement incomplete: a printhead replacement process has not completed successfully, re-
launch the replacement process and let it finish completely (it is not needed to change the
printheads).

e Remove: the printhead is not a suitable type for use in printing.
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Troubleshooting general printer issues

° The printer will not start

° The printer does not print

° The printer seems slow

e Communication failures between computer and printer

e Cannot access the HP Utility

e Cannot access the Embedded Web Server

e Automatic file system check

e An AutoCAD 2000 memory allocation error

° No output when printing from Microsoft Visio 2003

° Unavailable driver features when printing from QuarkXpress

° Printer alerts
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The printer will not start

If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are
recommended to replace the firmware, in the following way.

1.

2.

Go to the Knowledge Center (see Knowledge Center on page 188) and download the firmware.

Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted
with the FAT filesystem.

Ensure that the printer is turned off. Connect the USB flash drive to the printer's USB port, then
turn the printer on.

When prompted by the front panel, press the OK key.

The printer takes about a minute to read the firmware file, then asks you to remove the USB flash
drive.

The printer automatically installs the new firmware and restarts the printer.

The printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons
why a file you have sent from your computer may not start printing when expected:

You may have an electrical power problem. If there is no activity at all from the printer, and the front
panel does not respond, check that the power cable is connected correctly and that there is power
available at the socket.

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic

fields or severe electrical disturbances, which can cause the printer to behave strangely or even

stop working. In this case, turn off the printer using the Power key on the front panel and unplug

the power cord, wait until the electromagnetic environment has returned to normal, then turn it on
again. If you still experience problems, please contact your customer service representative.

Nesting may be on (T1200 series only) and the printer is waiting for the specified nest wait time
before calculating the appropriate nests. In this case, the front panel shows the remaining time
needed for nesting.

You may have the wrong graphic language setting, see Change the graphic language setting
on page 32.

You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

If you are printing on a sheet, you must specify Manual Feed as the paper source in your printer
driver.

The printer may be holding the job for paper or (T1200 series only) accounting information, see
Job status messages (T770 HD and T1200 series only) on page 111.

You may have requested a print preview (T1200 series only) from your printer driver. This is a
function you can use to check that the image is the one you want. In this case, the preview is
displayed on your screen, and you must click the Print button to start printing.

If you are using Mac OS with a USB connection, you may find that you need to change the data
encoding (PostScript printers only). Select the Setup menu icon , then Printing

preferences > PS > Select encoding > ASCII. Then configure your application to send ASCII
data.
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The printer seems slow

Here are some possible explanations.

e Did you set the print-quality to Best or Max Detail ? Best-quality and maximum detail prints take
longer.

e Did you specify the correct paper type when loading the paper? Some paper types require more
time for printing; for example, photo and coated papers require more drying time between passes.
To find out the printer's current paper type setting, see View information about the paper

on page 44.

e If your printer is connected by network, check that all components used in the network (network
interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a
lot of traffic from other devices on the network?

e If your printer is connected by USB, make sure that the USB host controller and the USB hubs
used (if any) are USB 2.0; and check that the USB cables are USB 2.0 certified.

e Did you specify Extended drying time in the front panel? Try changing the drying time to
Optimal.

Communication failures between computer and printer

Some symptoms are:

e The front-panel display does not show the Receiving message when you have sent an image to
the printer.

e Your computer displays an error message when you are trying to print.

e Your computer or printer hangs (stays idle), while communication is taking place.
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e Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

e Ensure that you have selected the correct printer in your application, see Printing on page 53.

e Ensure that the printer works correctly when printing from other applications.
e Remember that very large prints may take some time to receive, process and print.

e If the printer is connected to a network, try using it when connected directly to your computer
through a USB cable.

e Ifyour printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to
your computer.

e Try another interface cable.

e Ensure that the graphic language setting is correct, see Change the graphic language setting
on page 32.

e If the printer is connected with a USB, try to disconnect and reconnect the USB cable with the
computer. Also try using a different USB port on the computer.
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Cannot access the HP Utility

If you have not done so already, please read Access the HP Ultility on page 29.

L From the front panel, select the Connectivity menu icon .

2. Select Advanced > Web Services > HP Utility Software > Enable.

3. If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu
and select the Connectivity menu icon again.

4. Select the type of connection you are using.

5. Select View Information.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 29.

Bf NOTE: If you connect directly to your printer with a USB cable, use the HP Utility.

L From the front panel, select the Connectivity menu icon .

2. Select Advanced > Embedded Web Server > Allow EWS > On.

3. If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu
and select the Connectivity menu icon again.
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4. Select the type of connection you are using.

5.  Select View Information.
6. Ensure that you see IP enabled. If not, you may need to use a different connection.
If you are using a proxy server, try bypassing the server and accessing the Web server directly.

e In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more
precise control, click the Advanced button and add the printer's IP address to the list of exceptions,
for which the proxy server is not used.

° In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Automatic file system check

When you turn on the printer, you will occasionally see a front panel display similar to the one shown
below.
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A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

/A CAUTION: If you turn the printer off before the file system check has finished, the file system could
be seriously damaged, making the printer's hard disk unusable. In any case, the file system check will
restart from the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk’s file system integrity.

B NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and
prepare the printheads. However, it can take up to 40 under some conditions, for example, when the
printer has not been used for a long period of time and requires more time to prepare the printheads.

An AutoCAD 2000 memory allocation error

After installing the printer driver, when you try to print for the first time from AutoCAD 2000, you may
see a message saying Memory allocation error, after which your image is not printed.

This is due to a problem in AutoCAD 2000, and it can be fixed by downloading the Plotting Update Patch
(plotupdate.exe) from the Autodesk Web site, http://www.autodesk.com/.

This patch is also worth trying if you have any other strange problems when printing from AutoCAD
2000.
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No output when printing from Microsoft Visio 2003

For more information about problems when printing large images (more than 129 inches long) from
Microsoft Visio 2003, see Microsoft's online knowledge base: htip://support.microsoft.com/search/.

To avoid these problems, it is possible to scale the image down in Visio to a size shorter than 129 inches
and then to scale the drawing up in the driver by using the Resizing Options in the Features tab of the
Windows driver. If the down-scaling in the application and the up-scaling in the driver match, the result
is as originally intended.

Unavailable driver features when printing from
QuarkXpress

When you print from QuarkXPress, the following driver features are not available.
e  Print Preview

e Rotation

e Resizing

e Microsoft Office features or paper saving options

e  Back to front printing
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If you are using the HP-GL/2 and HP RTL driver, the following features are not available.

Print Preview

Back to front printing

To get the same results, use the equivalent features available in QuarkXPress.

Printer alerts

Your printer can communicate two types of alerts:

Errors: Mainly alerting you to the fact that the printer is unable to print. However, in the driver,
errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer
is able to print.

Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration
or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system.

ey

Front-panel display: The front panel shows only the most relevant alert at a time. It generally
requires the user to press the OK key for confirmation, but in the case of a warning, it disappears
after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear when
the printer becomes idle and there is not another more severe alert.

TIP:  From the front panel display you can configure paper mismatch alerts, see Handle paper
conflicts (T1200 series only)on page 22.

Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the
printer status. If there is an alert in the printer, the status shows the alert text.

Driver: The driver shows alerts. The driver warns about job configuration settings that may produce
a problem in the final output. If the printer is not ready to print, it displays a warning.

HP Utility: To see alerts, go to the Overview tab and review the Items needing attention list on
the right-hand side.

By default, alerts are only displayed when you are printing and there are printing problems, for
example: cartridge low or out of ink or printer out of paper. If alerts are enabled and there is a
problem that prevents printing, you see a pop-up window, which explains why the printer is not
going to print. Follow the instructions to achieve your required result.

NOTE: There are environments that do not support bidirectional communication, for example: a
Windows computer connected to the printer with USB. In those cases, alerts do not reach the job
owner.
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19 Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so, please
follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response,
contact HP Support. See Contact HP Support on page 190.

Table 19-1 Text messages

Message Recommendation

[Color] cartridge has expired Replace the cartridge. See Handling ink cartridges and
printheads on page 117.

[Color] cartridge is missing Insert a cartridge of the correct color. See Handling ink
cartridges and printheads on page 117.

[Color] cartridge is out of ink Replace the cartridge. See Handling ink cartridges and
printheads on page 117.

[Color] printhead #[n] error: not present Insert the correct printhead. See Handling ink carfridges and
printheads on page 117.

[Color] printhead #[n] error: please remove Remove the incorrect printhead and insert a new printhead of
the correct type (color and number). See Handling ink
cartridges and printheads on page 117.

[Color] printhead #[n] error: replace Remove the non-functional printhead and insert a new
printhead. See Handling ink cartridges and printheads

on page 117.

[Color] printhead #[n] error: reseat Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead.
See The front-panel display recommends reseating or
replacing a printhead on page 172.

[Color] printhead #[n] out of warranty The printhead's warranty has expired, because of the length of
time it has been in operation or because of the volume of ink
used.
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[Color] printhead #[n] warranty warning The printhead's warranty may be invalidated by the use of the
wrong kind of ink.

10 error Restart the printer. If the problem persists, contact HP Support.
See Contact HP Support on page 190.

10 warning Try again,; if the problem persists, contact HP Support. See
Contact HP Support on page 190.

Paper advance calibration pending Perform paper advance calibration. See Recalibrate the paper
advance on page 152.

Paper too small to print paper advance calibration Unload paper and load larger paper.
Paper too small to scan paper advance calibration Unload paper and load larger paper.
PDL Error: Ink system not ready Clean the printheads. See Clean the printheads on page 173.
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Table 19-1 Text messages (continued)

Message Recommendation

PDL Error: Job clipped The image is too large for the paper or for the printer. Load
larger paper if possible, or reduce the image size.

PDL Error: memory full Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

PDL Error: out of paper Load more paper.

PDL Error: parsing error The print job is unintelligible to the printer. Try to recreate and
resend it. Check your cable connections.

PDL Error: print mode error The paper type or print quality specified for the job are
incorrect. Change the loaded paper type or the print settings.

PDL Error: printing error Try sending the job again.

PDL Error: virtual memory full Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

Printhead alignment error: paper too small Unload paper and load larger paper.

Replace [color] cartridge Replace the cartridge. See Handling ink cartridges and
printheads on page 117.

Reseat [color] cartridge Remove and reinsert the same cartridge. See Handling ink
cartridges and printheads on page 117.

Update: failed. Invalid file Make sure that you have selected the correct firmware update
file. Then try again to perform the update.

Table 19-2 Numerical error codes

Error code Recommendation
01.0,01.1,01.2 Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 190.
21,21.1,22.0,22.1, 22.2, Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
223,24 on page 190.
T 61:01 The file format is wrong and the printer cannot process the job. Check the graphic language
8 setting of your printer (see Change the graphic language setting on page 32). If you are sending
> PostScript from Mac OS over a USB connection, select ASCII encoding in both the driver and
_g the application. Check for the latest firmware and driver releases.
% 62, 63, 64, 65, 67 Update your printer's firmware. See Update the firmware on page 131.
(0)
o 71.04 Out of memory. To avoid this, in the HP-GL/2 and HP RTL driver select the Advanced tab and
= then Send job as a bitmap.
(@)
a 741 Try the firmware update again. Do not try to use your computer while the update is in progress.
If the problem persists, contact HP Support. See Contact HP Support on page 190.
79:03 Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 190.
79:04 Update your printer's firmware. See Update the firmware on page 131.
81:01, 86:01 Please follow the instructions on the front panel. You may be asked to run a test procedure and
write down a numeric code before contacting HP Support. See Contact HP Support
on page 190.
94,941 Restart color calibration. See Color calibration on page 70.
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HP Customer Care

° Introduction

° HP Professional Services

e HP Instant Support

e HP Proactive Support

e Contact HP Support
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Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet,
providing comprehensive, proven support expertise and new technologies to give you unique end-to-
end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair
and exchange services, phone and Web support, software updates and self-maintenance services. To
find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts/

or call us on the telephone (see Contact HP Support on page 190). To register your warranty:

http://reqister.hp.com/

HP Professional Services

Knowledge Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from
your HP Designjet products and solutions.

Join the HP community at the Knowledge Center, your large-format printing community, for 24x7 access
to:

e  Multimedia tutorials

e  Step-by-step how-to guides

e Downloads — the latest printer firmware, drivers, software, paper presets, etc.
e Technical support — online troubleshooting, customer care contacts and more

e  Workflows and detailed advice for completing various printing tasks from particular software
applications

e Forums for direct contact with the experts, both HP and your colleagues

e  Warranty tracking online, for your peace of mind

e Latest product information — printers, supplies, accessories, software, etc.

e  Supplies Center for all you need to know about ink and paper

The Knowledge Center can be found at the following locations, depending on your printer:

° http://www.hp.com/qo/T770/knowledgecenter/

° http://www.hp.com/go/T770hdd/knowledgecenter/

° http://www.hp.com/qo/T1200/knowledgecenter/

° http://www.hp.com/go/T1200ps/knowledgecenter/

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the CD that comes with your printer; it contains the printer's software and
documentation.
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HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the
standard period.

They include remote support. On-site service is also provided if necessary, with two alternative
response-time options.

e Next business day
e Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/printservices/.

HP Installation

The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
printservices/.

HP Instant Support

HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic
information from your printer and match it with intelligent solutions from HP's knowledge bases, allowing
you to resolve problems as quickly as possible.

You can start an HP Instant Support session by clicking on the link provided on the Troubleshooting
page of your printer's Embedded Web Server. See Access the Embedded Web Server on page 29.

To be able to use HP Instant Support:

e You must have a TCP/IP connection to your printer, because HP Instant Support is accessible only
through the Embedded Web Server.

e You must have access to the World Wide Web, because HP Instant Support is a Web-based
service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional Chinese.

You can find more information about HP Instant Support at http://www.hp.com/go/ispe/.

HP Proactive Support

ENWW

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and
resolving printer issues before they become problems for you. HP's Proactive Support tool is designed
to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a
mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control
of your printing environment—with a clear focus on maximizing the value of your investment, increasing
printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems
before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for
software and firmware updates.

You can enable Proactive Support in the HP Utility for Windows or the HP Printer Monitor for Mac OS,
where you can specify the frequency of connections between your computer and HP's Web server, and
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the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To
change these settings:

e In the HP Utility for Windows, select the Tools menu, then HP Proactive Support.

° In the HP Printer Monitor for Mac OS, select Preferences > Monitoring > HP Proactive
Support.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the
problem and recommend a solution. In some cases, the solution may be applied automatically; in other
cases, you may be asked to perform some procedure to solve the problem.

Contact HP Support
HP Support is available to you by telephone. What to do before you call:
e Review the troubleshooting suggestions in this guide.
e Review the relevant driver documentation.
e If you have installed third-party software drivers and RIPs, see their documentation.

e If you call one of the Hewlett-Packard offices, please have the following information available to
help us answer your questions more quickly:

o The printer you are using (the product number and the serial number, found on the label at
the back of the printer)

0 If there is an error code on the front panel, note it down; see Front-panel error messages
on page 185

° The printer's Service ID: at the front panel, select the Information menu icon , then View
printer information
0 The computer you are using

o Any special equipment or software you are using (for example, spoolers, networks, switch-
boxes, modems or special software drivers)

o The cable you are using (by part number) and where you purchased it
o The type of interface used on your printer (USB or network)
o The software name and version you are currently using

o If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, Usage Report and “all pages above” from Service Information
(see The printer's internal prints on page 10)

Telephone number

Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/country/
us/en/wwcontact_us.html.
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Printer specifications

° Functional specifications

° Physical specifications

° Memory specifications

° Power specifications

° Ecological specifications

° Environmental specifications

e Acoustic specifications
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Functional specifications

Table 21-1 HP 72 ink supplies

Printheads Two inks in each printhead: gray and photo black, matte black and yellow, and
magenta and cyan

Ink cartridges Cartridges containing 69 ml of ink: gray, photo black, yellow, magenta and cyan

Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow, magenta
and cyan

Cartridges containing 300 ml of ink (T1200 series only): matte black only

Table 21-2 Paper sizes

Minimum Maximum
Roll width 11 inches (279 mm) 44 inches (1118 mm)
Roll length 300 feet (91.4 m)
Sheet width 8.3 inches (210 mm) 44 inches (1118 mm)
Sheet length 11 inches (279 mm) 66 inches (1676.4 mm)
Table 21-3 Printing resolutions
Print quality Maximum detail  Driver Rendering resolution (ppi) Printing resolution (dpi)
Best On Any 1200 x 1200 2400 x 1200 on glossy paper*
1200 x 1200 1200 x 1200 on other papers
Off Any 600 x 600 600 x 600
Normal On Any 600 x 600 600 x 600
Off HP-GL/2 600 x 600 600 x 600
PostScript 300 x 300 600 x 600
Fast On Any 600 x 600 600 x 600
Off HP-GL/2 600 x 600 600 x 600
PostScript 300 x 300 600 x 600
Economode Off Any 300 x 300 300 x 300

* For a list of supported glossy papers, see Order paper on page 136.

Table 21-4 Margins

Top, right and left margins 5 mm = 0.2 inches

Bottom margin (trailing edge) 5 mm = 0.2 inches (roll)

17 mm = 0.67 inches (sheet)

Table 21-5 Mechanical accuracy

+0.1% of the specified vector length or 0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AQO
printing material in Best or Normal mode with HP Matte Film roll feed.
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Table 21-6 Graphic languages supported

HP Designjet Languages

T770 HP PCL3 GUI, HP-GL/2 and HP RTL

T770 HD HP PCL3 GUI, HP-GL/2 and HP RTL, CALS

T770 PS HP PCL3 GUI, HP-GL/2 and HP RTL, PDF, PostScript

T1200 HP PCL3 GUI, HP-GL/2 and HP RTL, CALS

T1200 PS HP PCL3 GUI, HP-GL/2 and HP RTL, CALS, PDF, PostScript, TIFF, JPEG

Physical specifications

Table 21-7 Printer physical specifications

HP Designjet T770 series

HP Designjet T1200 series

Weight 180 Ib (81.6 kg) 189 Ib (86 kg)

Width 69.7 inches (1770 mm) 69.7 inches (1770 mm)

Depth Minimum: 27.2 inches (692 mm) Minimum: 27.2 inches (692 mm)
Maximum: 27.6 inches (702 mm) Maximum: 28.4 inches (722 mm)

Height 41.3 inches (1050 mm) 41.2 inches (1050 mm)

The depth is measured without the upper spindle; wall spacers up; ink cover opened; roll covers and

basket closed.

Memory specifications

Table 21-8 Memory specifications

HP Designjet Dedicated file-processing memory *  Hard disk
T770 2GB -

T770 HD 8 GB 160 GB
T1200 32GB 160 GB
T1200 PS 32GB 160 GB

* 384 MB physical DRAM

Power specifications

ENWW

Table 21-9 Printer power specifications

Source 100-240 V ac +10%, auto-ranging
Frequency 50-60 Hz

Current <2A

Consumption <200 W
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Ecological specifications

This product complies with European Union WEEE and RoHS Directives. To determine the ENERGY
STAR qualification status of these product models, please go to htip://www.hp.com/go/energystar/.

For the up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and search
for “ecological specifications”.
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Environmental specifications

Table 21-10 Printer environmental specifications

Temperature range Humidity range
Operating for optimal print-quality 22°C to 26°C (72°F to 79°F) 30% to 60%
Operating for standard printing 15°C to 35°C (59°F to 95°F) 20% to 80%
Printer without consumables 5°C to 40°C (41°F to 104°F)

Non-operating packed consumables and -40°C to 60°C (-40°F to 140°F)
printer:

Acoustic specifications
Printer acoustic specifications (declared according to ISO 9296).

Table 21-11 Printer acoustic specifications

Idle sound power level 4.4 B (A)
Operating sound power level 6.3 B (A)
Idle sound pressure at bystander position 29dB (A)
Operating sound pressure at bystander position 46 dB (A)
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HP Designjet T770 and T1200 accessories
Hewlett Packard Limited Warranty Statement

HP product Limited warranty period
HP hardware product 1 year
HP software product 90 days

A. Extent of HP Limited Warranty

1.

HP warrants to you, the end-user customer, that the HP hardware products will be free from defects
in materials and workmanship under normal usage during the Limited Warranty Period specified
above. The Limited Warranty Period starts on the date of purchase by you. Your dated sales or
delivery receipt, showing the date of purchase of the product, is your proof of purchase date. You
may be required to provide proof of purchase as a condition of receiving warranty service.

For software products, HP’s Limited Warranty applies only to a failure to execute programming
instructions for the Limited Warranty Period specified above, due to defects in material and
workmanship, when properly installed and used on the device designated by HP. HP further
warrants that HP-owned standard software will substantially conform to specifications. HP does
not warrant that software will operate in hardware and software combinations selected by you, or
meet requirements specified by you.

HP does not warrant that the operation of any product will be uninterrupted or error-free.

HP’s Limited Warranty covers only those defects that arise as a result of normal use of the HP
products, and does not cover any other problems, including those that arise as a result of:

a. Improper or inadequate maintenance or calibration

b. Accessories, software, interfacing, paper, parts, ink or supplies not provided or supported by
HP

c. Operation outside the product's specifications
d. Improper site preparation or maintenance
e. Unauthorized modification or misuse

If HP or an HP authorized service provider receives, during the applicable warranty period, notice
of a defect in any product covered by this HP Limited Warranty, HP shall, at its option, either repair
or replace the product that proved to be defective.

Customer self-repair warranty service. HP products are designed with many Customer Self-
Repair (CSR) parts to minimize repair time and allow for greater flexibility in performing defective
parts replacement. If during the diagnosis period, HP identifies that the repair can be accomplished
by the use of a CSR part, HP will ship that part directly to you for replacement. There are two
categories of CSR parts: 1) Parts for which customer self-repair is mandatory. If you request HP
to replace these parts, you will be charged for the travel and labor costs of this service. 2) Parts
for which customer self-repair is optional. These parts are also designed for Customer Self-Repair.
If, however, you require that HP replace them for you, this may be done at no additional charge
under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next-business-
day delivery. Same-day or four-hour delivery may be offered at an additional charge where
geography permits. If assistance is required, you can call the HP Technical Support Center and a
technician will help you over the phone. HP specifies in the materials shipped with a replacement
CSR part whether a defective part must be returned to HP. In cases where it is required to return
the defective part to HP, you must ship the defective part back to HP within a defined period of
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time, normally five (5) business days. The defective part must be returned with the associated
documentation in the provided shipping material. Failure to return the defective part may result in
HP billing you for the replacement. With a customer self-repair, HP will pay all shipping and part
return costs and determine the courier/carrier to be used.

7. Should HP elect to replace or repair the defective product or part onsite, such products will be
serviced at the end-user customer's facility at no charge only within designated local service travel
areas. Outside designated local service travel areas, warranty services will be performed at the
end-user customer's facility only upon prior agreement; you may be required to pay travel expenses
and other applicable expenses for such services. Contact your local HP authorized service provider
for details on local travel areas.

8.  You will make all reasonable efforts to support and cooperate with HP or an HP authorized service
provider in resolving the problem remotely, for example, starting and executing self-tests or
diagnostic programs, providing all necessary information, or performing basic remedial activities
upon the request of HP or an HP authorized service provider.

9. If HP is unable to repair or replace, as applicable, a defective product which is covered by this
Limited Warranty, HP shall, within a reasonable time after being notified of the defect, refund the
residual value of the product. The residual value will be the purchase price paid to HP or an HP
Authorized Reseller minus depreciation and amortization.

=
=
T
€
o
@)
y—
=
[
(o)
(D)
—

10. HP shall have no obligation to replace or refund until you return the defective components, parts,
supplies or hardware product to HP, including its associated documentation. All components, parts,
supplies or hardware products removed under this Limited Warranty become the property of HP.
Notwithstanding the above mentioned, HP may waive the requirement for you to return the
defective product.

11. Unless otherwise stated, and to the extent permitted by local law, HP products may be
manufactured using new materials or new and used materials equivalent to new in performance
and reliability. HP may repair or replace products (i) with equivalent products to the products being
repaired or replaced but which may have been subject to prior use; or (ii) with an equivalent product
to an original product that has been discontinued.

12. This Limited Warranty is valid in any country/region where HP or its authorized service providers
offer warranty services and HP has marketed the HP product covered by this Limited Warranty.
However, warranty service availability and response time may vary from country/region to country/
region. HP will not alter form, fit, or function of the product to make it operate in a country in which
it was never intended to function for legal or regulatory reasons. This HP Limited Warranty is subject
to all applicable laws and regulations including US and other national export and import laws and
regulations.

13. Contracts for additional services may be available from any authorized HP service facility where
the listed HP product is distributed by HP or an authorized importer.

14. You are responsible for the security of your proprietary and confidential information and for
maintaining a procedure external to the HP product for reconstruction of lost or altered files, data
or programs. HP IS NOT RESPONSIBLE FOR DAMAGE TO OR LOSS OF ANY FILES STORED
BY YOU ON THE HP PRODUCT'S HARD DISK OR OTHER STORAGE DEVICES. HP IS NOT
RESPONSIBLE FOR THE RECOVERY OF LOST FILES OR DATA.

B. Limitations of warranty

TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS
MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR
IMPLIED, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
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C. Limitations of liability

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS LIMITED WARRANTY ARE
YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE. IN NO EVENT WILL
HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR LOSS OF DATA, DIRECT, INDIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING ANY LOSS OF PROFITS
OR SAVINGS), WHETHER BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY, AND
WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

D. Local law

1.  This Limited Warranty gives you specific legal rights. You may also have other rights which vary
from state to state in the United States, from province to province in Canada, and from country to
country elsewhere in the world. You are advised to consult applicable state, province, or national
laws for full determination of your rights.

2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement
shall be deemed modified to be consistent with such local law. THE WARRANTY TERMS
CONTAINED IN THIS LIMITED WARRANTY, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Rev. 05/09
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Hewlett-Packard Software License Agreement

ENWW

PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO
NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE
RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A
REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE
AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third
Party Licenses include licenses that provide for the availability of source code (such as the GNU
General Public License) and the corresponding source code is not included with the Software, then
check the product support pages of HP’s website (hp.com) to learn how to obtain such source
code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing,
copying, storing, loading, executing, displaying, or otherwise using the HP Software. You may
not modify the HP Software or disable any licensing or control feature of the HP Software. If
this Software is provided by HP for Use with an imaging or printing product (for example, if
the Software is a printer driver, firmware, or add-on), the HP Software may only be used with
such product (“HP Product”). Additional restrictions on Use may appear in the User
Documentation. You may not separate component parts of the HP Software for Use. You do
not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the
HP Software, provided each copy contains all the original HP Software’s proprietary notices
and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as
eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may
no longer use such HP Software. This EULA applies to each Upgrade unless HP provides other
terms with the Upgrade. In case of a conflict between this EULA and such other terms, the other
terms will prevail.
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4.  TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer
of the HP Software to another end user. Any transfer will include all component parts, media,
User Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer
may not be an indirect transfer, such as a consignment. Prior to the transfer, the end user
receiving the transferred Software will agree to this EULA. Upon transfer of the HP Software,
your license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer
the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation
are owned by HP or its suppliers and are protected by law, including applicable copyright, trade
secret, patent, and trademark laws. You will not remove any product identification, copyright notice,
or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s
privacy policy. HP will not use such information in a form that personally identifies you except to
the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited
to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
(INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF
ITS ESSENTIAL PURPOSE. Some states or other jurisdictions do not allow the exclusion or
limitation of incidental or consequential damages, so the above limitation or exclusion may not

apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Ifyou are a U.S. Government entity, then consistent with FAR
12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation,
and Technical Data for Commercial ltems are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

© 2007 Hewlett-Packard Development Company, L.P.
Rev. 11/06
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Open-source software

Open source acknowledgments

e This product includes software developed by the Apache Software Foundation
(http://www.apache.org/).

e The source code, object code, and documentation in the com.oreilly.servlet package is licensed
by Hunter Digital Ventures, LLC.

e This software is based in part on the work of the Independent JPEG Group.

e Regular expression support provided by the PCRE library package, which is open source software
written by Philip Hazel, and copyright by the University of Cambridge, England. Source at
ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre.

e This software includes cryptographic software written by Eric Young (eay@cryptsoft.com).

Open source written offer
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In accordance with the GNU General Public License, the SMAIL General Public License, and the Sleepy
Cat software license, HP is providing you with this written offer to receive on a CD-R, at the cost of $30,
a complete machine-readable copy of the source code corresponding to all the code distributed to you
under a GNU General Public License, SMAIL General Public License, and/or Sleepy Cat software
licenses. You can request this CD-R from your local HP support representative; telephone numbers and
e-mail addresses can be found at http://www.hp.com/go/designjet/support/.
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Regulatory notices
MSDS (Material Safety Data Sheet)

You can obtain current Material Safety Data Sheets for the ink systems used in the printer by mailing a
request to this address: Hewlett-Packard Customer Information Center, 19310 Pruneridge Avenue,
Dept. MSDS, Cupertino, CA 95014, U.S.A.

There is also a Web page: http://www.hp.com/hpinfo/community/environment/productinfo/
psis_inkjet.htm

Regulatory Model Number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is BCLAA-0608. This regulatory number should not be
confused with the marketing name (such as HP Designjet printer) or product numbers (such as Z##HH#X,
where Z and X are any single letter and # is any number).

Regulatory statements
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European Union
Ecological

Eco-tips

HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-
tips below to help you focus on ways to assess and reduce the impact of your printing choices. In addition
to specific features in this product, please visit the HP Eco Solutions Web site (http://www.hp.com/hpinfo/
globalcitizenship/environment/) for more information on HP’s environmental initiatives.

Environmental product stewardship program

Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design
for recycling has been incorporated into this product. The number of materials has been kept to a
minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to
separate easily. Fasteners and other connections are easy to locate, access and remove using common
tools. High-priority parts have been designed to access quickly for efficient disassembly and repair. For
more information, visit HP's Commitment to the Environment Web site at http://www.hp.com/hpinfo/
globalcitizenship/environment/.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of product life.

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronics recycling centers throughout the world. HP conserves
resources by reselling some of its most popular products. For more information regarding recycling of
HP products, please visit http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/.

HP ink supplies recycling program

HP is committed to protecting the environment. The HP Ink Supplies Recycling Program is available in
many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For
more information, go to the following Web site: http://www.hp.com/hpinfo/globalcitizenship/environment/

recycle/.
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Battery directive

This product contains a battery that is used to maintain data integrity of real-time clock or product
settings and is designed to last the life of the product. Any attempt to service or replace this
battery should be performed by a qualified service technician.

Lithium battery

This HP product contains a lithium battery located on an internal motherboard that may require special
handling at the end of its life.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No. 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be found
at http://www.hp.com/go/reach/.

Disposal of waste equipment by users in private households in the European Union

This symbol on the product or on its packaging indicates that this product must not be disposed =
of with your other household waste. Instead, it is your responsibility to dispose of your waste ( ;\

equipment by handing it over to a designated collection point for the recycling of waste electrical

and electronic equipment. The separate collection and recycling of your waste equipment at the

time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that
protects human health and the environment. For more information about where you can drop off your
waste equipment for recycling, please contact your local city office, your household waste disposal
service or the shop where you purchased the product.

Sound (Germany)

U.S.A.

Gerauschemission (Germany) LpA < 70 dB, am Arbeitsplatz, im Normalbetrieb, nach DIN45635 T. 19.

Electromagnetic compatibility (EMC)

FCC statements (U.S.A.)

Note

ENWW

The U.S. Federal Communications Commission (in 47 cfr15.105) has specified that the following notices
be brought to the attention of users of this product.

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Shielded cables: use of shielded data cables is required to comply with the Class B limits of Part 15 of
the FCC Rules.

CAUTION: Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment
not expressly approved by the Hewlett-Packard Company may cause harmful interference and void the
FCC authorization to operate this equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur
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http://www.hp.com/go/reach/

in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

Reorient the receiving antenna.

Increase the separation between the equipment and the receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

Consult your dealer or an experienced radio/TV technician.

For further information, contact:

Manager of Corporate Product Regulations
Hewlett-Packard Company

3000 Hanover Street

Palo Alto, CA 94304
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(650) 857-1501

Power consumption

Cut sheet printing: To ensure best print quality and customer experience, the printer will enter a low
energy state only after the default sleep mode wait time and once the print job is completed.

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to
the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The
following mark will appear on ENERGY STAR qualified imaging products:

ENERGY STAR

Additional ENERGY STAR qualified imaging product model information is listed at http://www.hp.com/
go/energystar/.

Ecological

Attention California users

The battery supplied with this product may contain perchlorate material. Special handling may apply.
See hitp://www.dtsc.ca.gov/hazardouswaste/perchlorate/ for information.

Atencién alos usuarios de California

La pila proporcionada con este producto puede contener perclorato. Podria requerir manipulacion
especial.

Consulte http://www.dtsc.ca.gov/hazardouswaste/perchlorate/ para obtener mas informacion.
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Canada
Electromagnetic compatibility (EMC)

Normes de sécurité (Canada)

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables
aux appareils numériques de Classe B prescrites dans le réglement sur le brouillage radioélectrique
édicté par le Ministére des Communications du Canada.

DOC statement (Canada)

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
set out in the Radio Interference Regulations of the Canadian Department of Communications.

Turkey
Turkiye Cumhuriyeti: EEE Yonetmeligine Uygundur
Republic of Turkey: In conformity with the EEE Regulation

=
=
T
€
o
@)
y—
=
©
(o)
(D)
—

Korea

AREAR Pt A 7)7]

ol N7 PTEOE AAAAFERE W J)vlol o, BulA Ei
AgAE o) e Fo A7) viekel, wep A% 79 S Wl
T FlA MPTgOoT W kA7) whgch

Japan
COFEEF, V757ABIEHREMEETY . COEEX. K
ERETHEATASICEZHBNE LTLEITA, :m%ﬁﬁ
FUFOTLED 3 URERICEEL TERASNS L.
EE%%%%EHThaﬁ&U$TOmmﬂﬁ%kﬁot
ELWLERYIFEWLWELTTEL,
VCCI-B

Safety power cord warning

MRk, RS Wi-EBRa —F 2BV FI 0,
RS hi-EBFR= —F %, oS TiERHEE A,

Taiwan
Ll9 mmtamy

China

AREFEAETHARLTHRERERESE L
BAELEBAREXHMMAEAE L,

ENWW Regulatory notices 205



T ABAEDEILE
A K = 7~ EE ZIREE | ZRELFER

SN EFISELS 0 0 0 0 0 0
HZ* 0 0 0 0 0 0
ED Rl s R AR X 0 0 0 0 0
FIED R ™ X 0 0 0 0 0
Eeet X 0 0 0 0 0
E BTN BE 0 0 0 0 0 0

3 WA X 0 0 0 0 0

s R X X 0 0 0 0

= P F A X 0 0 0 0 0

% B AR X 0 0 0 0 0

2 EHMETDEL | 0 0 0 0 0 0

S SR E i X 0 0 0 0 0
0: JRILEMERIBIBY—HMREFEEMNXMESEEYR, SEET SI/T113463-2006 RIBE
X: BUEMERANS—HRFZELE—MESHIMEEEETWR, SEST SI/T113632006 HIFRG
. IMR(E IR SRR EUR TS TR RR PR
I R T R AR P

206 Chapter 22 Legal information ENWW



Declaration of conformity
according to ISO/IEC 17050-1 and EN 17050-1

Declaration of conformity number: BCLAA-0608-08
Supplier's name: Hewlett-Packard Company
Supplier's address: Avenida Graells, 501

08174 Sant Cugat del Valles

Barcelona, Spain

declares that the product

Product name and model: HP Designjet Z3100/23200/Z22100 Photo printer series
HP Designjet T1100/T1120/T1200 printer series

HP Designjet T610/T770 printer series

Regulatory Model Number (: BCLAA-0608

Product options: All

conforms to the following product specifications

Safety: IEC 60950-1:2005 (2nd Edition) / EN 60950-1:2006

CAN/CSA-C22.2 No. 60950-1-07 / UL 60950-1:2007

EMC: EN 55022:2006 / CISPR 22:2005 Class B
EN 55024:1998 + A1:2001 + A2:2003
EN 61000-3-2:2006 / IEC 61000-3-2:2005
EN 61000-3-3:1995 + A1:2001 / IEC 61000-3-3:1994 + A1:2001

FCC Title 47 CFR, Part 15 Class B

The product herewith complies with the requirements of the Low-Voltage Directive 2006/95/EC and the
EMC Directive 2004/108/EEC, and carries the c e marking accordingly. In addition, it complies with

the WEEE Directive 2002/96/EC and RoHS Directive 2002/95/EC.
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
e This device may not cause harmful interference.

e This device must accept any interference received, including interference that may cause
undesired operation.

Additional information

1. The product is assigned a Regulatory Model Number which stays with the regulatory aspects of the
design. The Regulatory Model Number is the main product identifier in the regulatory documentation
and test reports; this number should not be confused with the marketing name or the product numbers.
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A

Viceng Llorens
Product Regulations Manager
Sant Cugat del Vallés (Barcelona)

June 15th, 2009

Local contacts for regulatory topics only

http://www.hp.com/go/certificates/

EMEA contact: Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 Boblingen,
Germany.

USA contact: Hewlett-Packard Company, Corporate Product Regulations Manager, 3000 Hanover
Street, Palo Alto, CA 94304, USA. Phone: (650) 857 1501.
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Glossary

AppleTalk
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends
TCP/IP networking instead.

Bonjour

Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer
network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available
on a local area network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have
a limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space

A color model in which each color is represented by a specific set of numbers. Many different color spaces can
use the same color model: for instance, monitors generally use the RGB color model, but they have different color
spaces, because a particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD

ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the
cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic
discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some
precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may
reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type
of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD
sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic
charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when
handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

HP RTL
Hewlett-Packard Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.
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HP-GL/2
Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.

I/0
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color
profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers separated by
dots.

Jetdirect
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-
level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are
pulped, dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead

A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and
deposits it on the paper, through a cluster of nozzles. In the HP Designjet T770 and T1200 series, each printhead
prints two different colors.

Rendezvous
Apple Computer's original name for its networking software later known as Bonjour.

Spindle
A rod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers.
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black and white 62
black point compensation 78
blurred lines 160
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clean the platen 163
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printer emulation 4

profile 70
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color management
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from EWS [T1200] 77
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from PS drivers 75
options 72
process 70
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components of printer 5
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printer/computer
communications issues 181
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connect the printer
choose a method 12
Mac OS direct 17
Mac OS network 14
Windows direct 12
Windows network 12
contrast in front panel 31
core adaptors 36
crop lines [T1200] 63
Customer Care 188
cutter
on/off 46

D
disk erase, secure 132
draft for revision, print 82
draft printing 60
driver features
QuarkXpress 183
driver preferences 25
drying time
change 46

E
ecological specifications 194
economize
onink 66
on paper 51
Embedded Web Server
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cannot access 30

ink and paper usage 114

job preview [T1200] 109

job queue [T1200] 108

language 30

printer usage statistics 114
environmental specifications 156
erase hard disk securely 132
error messages, front panel 3
external hard disk [T1200] 140

F

fading colors 166
features of printer 4
file system check 182
firmware update 9

front panel
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language 29
units 31

front panel key
form feed and cut 8
pause printing [T1200] 8
unload paper [T770] 8
view information 8
view ink levels 8

front panel option
adjust paper advance 153
align printheads 177
allow EWS 182
black point compensation 80
calibrate color 71
calibrate paper advance 153
clean printheads 173
CMYK source profile 80
color/grayscale 79
emulate printer 79
enable buzzer 30
enable crop lines 63
enable cutter 47
enable economode 61
enable maximum detail 62
enable merge 59

Index 211



form feed and cut 46, 47,
151, 152
HP Utility software 182
ink cartridge information 118
internal prints 10
modify configuration 31
move paper 45
PANTONE emulation 80
paper mismatch action 22
print diagnostic image 168
print quality 55
printhead information 121,
158, 161
rendering intent 80
replace ink cartridges 119
replace printheads 122
reprint 111
reprint last job 64
reset paper advance 154
resize 59
RGB source profile 79
roll protection 66
roll switching options 22
select active roll 22
select display contrast 31
select drying time 46
select graphics language 32
select I/O timeout 166
select language 29
select paper size 56
select paper type 146
select units 31
select wait time 65
sleep mode wait time 30
unload paper 40
view configuration 14
view connectivity
information 182
view loaded paper 44
view printer information 190
front view 5
functional specifications 145

G

graininess 161
graphic languages 193
gray shades 62

H

hard disk specification 193
hard disk, external [T1200] 140
HP Care Packs 189

HP Customer Care 188

HP Installation 189
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HP Instant Support 189
HP Proactive Support 189
HP Start-Up Kit 188
HP Start-Up KitCD 2
HP Support 2
HP Utility
access 4
cannot access 29
language 30
HP-GL/2 32

I

image diagnostics print 157

image problems
clipped at bottom 166
clipped image 166
missing objects 167
PDF problems 167
Visio 2003 183

ink
economical use of 66
usage 114

ink cartridge
about 118
cannot insert 121
insert 120
maintenance 130
order 136
remove 118
specification 192
status 8

Instant Support 189

internal prints 10

IP address 30

J
Jetdirect print server 141
job
create 54
submit [T1200] 54
job preview
Embedded Web Server
[T1200] 109
job queue
Embedded Web Server
[T1200] 108
job status 111

K
Knowledge Center 2

L
language 29
line length accuracy 161

line thickness 158

load paper
cannot load 40
general advice 34
paper not in driver 40
roll cannot load 144
roll into printer 37
roll onto spindle 35
sheet 41
sheet cannot load 145

loading paper problems 40

M
maintenance kits 132
margins

none [T1200] 57

specification 192
mechanical accuracy 192
memory error (AutoCAD) 183
memory specifications 193
memory upgrade [T770] 140
Microsoft Office

print from 101
misaligned colors 159
models, printer 3
move the printer 130
multiroll printer [T1200] 3

N
nesting [T1200]

turn on and off 22
Network settings 31

O
on hold for paper
enable/disable 148
message [T1200] 147
order
accessories 140
ink cartridges 136
paper 136
printheads 136
overlapping lines 59
overnight printing [T1200] 50

P
page size 55
PANTONE emulation 75
PANTONE swatch book 78
paper
advance 8
calibrate the paper
advance 152
cannot load 40
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download presets 45
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feed and cut 8
jammed 148
loading error messages
maintenance 46
movement 45
not flat 162
output problems in basket
paper not in driver 40
presets 45
print on loaded paper
printed on wrong paper
select type 58
size 55
sizes (max and min)
usage 114
view information 8
paper conflicts, handle
[T1200] 22
paper mismatch action
[T1200] 22
paper not in driver 40
paper types 136
PDF clipped 167
PDF missing objects
physical specifications
platen cleaning 163
ports 7
PostScript upgrade [T770]
power
on/off 28
power specifications 193
preferences, Windows driver 25
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preview a print 13
print file [T1200] 54
print job
create 54
ink usage 114
nesting [T1200] 22
paper usage 114
submit [T1200] 54
print preview 13
print quality
select 55
print with shortcuts 57
print-quality problems
banding 157
black ink comes off 164
blurred lines 160
bottom of print 164
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sharp 164
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inaccurate line lengths 161
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line thickness 158
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paper not flat 162
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scuffing 44
stepped lines 158
vertical lines of different
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white spots
wizard 156
printer does not print
printer models 3
printer software
Mac OS uninstall 18
Windows uninstall 13
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printer will not start 180
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spindle load 35
unload 40
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S
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mechanical accuracy
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unattended printing [T1200] 50
unload paper
roll 40
sheet 43
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using this guide 2
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warranty extensions 189
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